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Boundaries Unlimited, Inc. proudly presents --   

  

the easy way to manage your reciprocal websites links! 
  

LinKtoLinK provides a total solution to managing reciprocal website links.  It helps 
you: 

√√ Make offers through its standardized e-mail service; 

√√ Organize the status of each link through its simple filing structure; and 

√√ Check the presence of each implemented link through its rule-based, automatic link 
tester. 

  

It comes in two versions. 

√√ The free unregistered version provides basic services to manage an unlimited number 
of reciprocal links for one website.  

√√ Registering LinKtoLinK turns it into a Pro version.  LinKtoLinK Pro enables you to 
manage an unlimited number of websites and corresponding links and has many 
additional productivity features geared to the professional. 

  

Both are loaded with features: 

√√ Intuitive main screen.  Website and corresponding link information is presented in split 
panes similar to Windows Explorer.  Plus it has a third pane at the bottom to display e-
mail and link testing activity. 

√√ Makes it easy to keep track of your reciprocal links. 

• Organizes reciprocal links to each of your websites into 6 status categories: 

◊◊ Offer (making an offer or waiting for a response); 

◊◊ In-Process (offer accepted, but links not yet implemented); 

◊◊ Active (agreed-to links are present when tested); 

◊◊ Broken (one or more agreed-to links are no longer present or there is some other 
problem such as the server for website is not responding); 

◊◊ Inactive (link is no longer active); and 

◊◊ Declined (offer was refused). 

• Provides tabs so you can easily view those links having a particular status. 
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• Tests each specified link.  (You must have an active Internet account and be using 
Internet Explorer 4.0+, Netscape 4.0+, or AOL Browser 4.0+ as your default 
browser.)  Based on the test rules selected in your site’s properties, LinKtoLinK will 
test: 

◊◊ Your link on someone else's link page; 

◊◊ Your image, such as a banner or icon, on someone else's link page; 

◊◊ The reciprocal link on your site’s link page; and 

◊◊ The reciprocal image, such as a banner or an icon, on your link page.  

• Automatically changes link status based on test results: 

◊◊ Moves a link to "Broken" if an agreed-to link is not found or there is no server 
response from a website. 

◊◊ Moves broken links back to "Active" if the agreed-to links are later found. 

• Has easy-to-interpret icons on the main screen so you can quickly determine a 
link's status and its test results. 

√√ Versatile E-Mail Service. 

• Select and send 8 different e-mail messages  (7 pre-defined and 1 user-defined).  
This set of messages can be different for each of your websites. 

• Change messages to meet your special needs by using the e-mail template editor.  
18 tag fields are available to insert information from your LinKtoLinK site and link 
properties so that you can make each message as personalized as possible. 

• Proof each template with a built-in spell checker. 

• Attach a file to any e-mail template.  Great for including an image file with your 
correspondence. 

• Preview e-mail messages for completeness before sending them. 

• Receive blind carbon copies (bcc:'s) of the e-mails you send (optional). 

• You must have an active SMTP Internet e-mail account to send e-mail messages.  
Note that America On Line (AOL) has a proprietary network which may not permit 
you to send e-mails using LinKtoLinK.  With AOL you may have to cut and paste 
messages from the e-mail template screen then manually edit and use AOL's e-mail 
service.  

√√ Results log and site report. 

• Watch e-mail and test activity on the Results Log pane of the main screen in real-
time.  Print, save, or delete the log as desired. 

• Use site report for reference purposes. 

√√ Backup services. Maintain a backup database on any available drive including floppies 
and zip disks.  Protect against data losses from a power outage while working in 
LinKtoLinK or against other unforeseen catastrophes! 
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√√ Utilities to repair and compact the LinKtoLinK database. 

√√ Extensive Training and Help Services. 

• Numerous Tips available at startup to introduce LinKtoLinK features and to give 
productivity suggestions.  

• Over 80 topics in the on-line, context-sensitive Help System including a tutorial, a 
visual glossary, and frequently asked questions. 

√√ As a 32-bit application, LinKtoLinK runs on Windows 95b and 98 and on Windows NT 
Version 4 (service pack 3 or higher). 

√√ Available by download from www.linktolink.com and from numerous shareware 
websites. 

 
 LinKtoLinK Pro has all of the LinKtoLinK features, plus: 

√√  Manage an unlimited number of websites, instead of just 1! 

√√  Assign categories to your reciprocal links to better organize them.  You can even 
maintain different categories for each of your sites! 

√√  Use the import service to harvest links at a specified URL. 

√√  Use the export service to generate a categorized links page in html from your active 
reciprocal link list.  (It even includes an option to generate a temporary link page 
containing only links not previously exported so you can easily cut and paste them into 
an existing link page.) 

√√ Change the titles of any of the 7 standard e-mail templates, enabling you to have 8 user-
defined messages instead of 1! 

√√ Include special instructions and HTML code stored in the LinKtoLinK database when 
you e-mail your fellow webmasters.  

√√ View the page where a selected reciprocal link resides.  LinKtoLinK can 
automatically launch your default Internet browser to the specified address. 

√√  Customize Link List on the main screen with 6 additional column fields.  Change 
column order and which fields are displayed. 

√√  Technical Support.  (No support is provided on the free unregistered version.) 

  

 As you can see from the above, LinKtoLinK offers many powerful features to save 
you time and increase your webmaster productivity.  We do, however, expect you to 
follow proper Internet etiquette in its use. 



   LinKtoLinK User’s Guide                                                                                                  Page 8 of 94 
 

Installation  
  

From Download  

Download the selected program into your designated directory.  Using Windows Explorer, 
double click on the downloaded program.  Follow the instructions provided in the setup 
program to install LinKtoLinK.  Its files will be copied to C:\Program Files\LinKtoLinK 
unless you specify a different directory.  The setup program concludes by creating a 
"LinKtoLinK" program group and placing icons in the program group to access LinKtoLinK, 
our website, and the help system. 

  

From CD-ROM 

Insert the Boundaries Unlimited CD-ROM in your CD drive.  The installation browser 
should automatically launch itself.  If it does not, click on the Start button in Windows 
desktop and then select "Run" in the Start menu.  Type "d:setup" in the dialog box as shown 
below;  then click the OK button and follow the instructions presented to you. 

  
 

(The above assumes that drive D: is your CD-ROM drive.  If it is not, type the correct drive 
letter, accordingly.)  

Once loaded, follow the instructions provided in the multimedia CD browser to install 
LinKtoLinK.  Its files will be copied to C:\Program Files\LinKtoLinK unless you specify a 
different directory.  The setup program concludes by creating a "LinKtoLinK" program 
group and placing icons in the program group to access LinKtoLinK, our website, and the 
help system. 

  

First Time In 

The first time you run LinKtoLinK you will be taken to a Trial Screen.  From here, click the 
OK-button to begin your 15-day free evaluation (LinKtoLinK only) or click the Register-
button to enter your name and registration code (LinKtoLinK  and LinKtoLinK Pro). 

Go to the "How To Register" chapter for more information on the registration process. 
  

Uninstall  

You can unistall LinKtoLinK from the "Add/Remove Programs" service in your Windows 
Control Panel. 
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Quick Start  
  

Here's how we suggest you start:  

√√ The first time you run LinKtoLinK you will be taken to a Welcome help screen.  When 
you close the Help System, you will be presented with your first training tip and then 
taken to the LinKtoLinK main screen.   

√√ Look around the main screen which is the control center for LinKtoLink.  Notice that it 
is organized similar to Windows Explorer with split panes.  Look at the sample 
information in these panes to see how the lists are organized. 

√√ The left pane maintains your website information (aptly called "My Sites").  My Sites 
list works like the directory tree in Windows Explorer -- as you highlight different sites, 
the right pane displays different information.  The right pane maintains the Reciprocal 
Links list for your highlighted site.  Notice that it is organized with tabs. 

√√ Double click on the entry in My Sites list to see the properties associated with each of 
your sites.  Then double click on an entry in Reciprocal Links list to see its properties. 

√√ Click on the  button that appears below the menu bar to receive an orientation 
on how to organize your link information, to preview and send e-mails, and to test links. 

√√ To quit LinKtoLinK, just click on  in the title bar or on "File" and then "Exit"  in the 
menu bar . 

 We suggest that you do not delete the sample "My Site" and its associated links until you 
have LinKtoLinK fully functioning with your data.  Use the sample sites and links with the 
tutorial where it is transformed into your first site!  The sample site and links are great as 
format examples and for initial e-mail and link testing. 

  
For those who need a refresher on Windows and Help System navigation: 

√√ The Help Service contains many hypertext links.  They come in two forms:  green text 
with either solid or dotted underlines.  Click on the solid underlines and you will be 
taken to a new screen of related information.  Click on dotted underlines and you will 
receive a pop-up containing additional information.  Click on it a second time to close 
the pop-up. 

√√ Those of you familiar with Windows programs will be right at home with the way 
LinKtoLinK uses your mouse and keyboard.  Those with a DOS orientation should 
remember that the TAB key is used to move from one screen element to another, not the 
Enter key.  The visual glossary shows the many Windows controls used in LinKtoLinK. 

√√ Pressing the F1 key or clicking on "Help" and then "Contents"  in the menu bar of the 
main screen takes you to the Help Table of Contents. 

√√ Clicking  in the main screen or  in other screens takes you to context-sensitive 
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help information.  

√√ Keep your eyes out for the  symbol in the Help Service.  It offers special suggestions 
and tips.  

√√ To exit help, click on the  button that appears below the menu bar of each help 
screen. 
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Tutorial 
  

This tutorial will walk you through many of the LinKtoLinK features and give you the 
opportunity to e-mail sample offers and to test sample reciprocal links.  Progressively, 
you will change the sample "My Sites" entry in My Sites list into one of your own 
websites to get you going! 

LinKtoLinK provides a total solution to managing reciprocal website links.  It helps you:  
make offers through its standardized e-mail service;  organize the status of each link through 
its simple filing structure;  and check the presence of each implemented link through its 
automatic link tester.  We expect you to follow proper Internet etiquette in its use. 

We also assume that you have not changed the sample information contained in the 
LinKtoLinK database.  

  

The tutorial is organized into the following steps: 

 1.  Main screen 
 2.  Reciprocal Links list organization 
 3.  Site Properties tour 
 4.  Link Properties tour 
 5.  Program Options tour 
 6.  E-Mail Template tour 
 7.  Preview E-mail service 
 8.  Send E-mail service 
 9.  Test Links service 
       10.  Suggested strategy for putting in your information into LinKtoLinK 

  
 1.  Main screen 

 We'll start from the main screen, the control center for LinKtoLink.  Notice that it is 
organized similar to Windows Explorer with split panes.  Look at the sample 
information in these panes to see how the lists are organized. 

  

 The left pane maintains your website information (aptly called "My Sites").  My Sites 
list works like the directory tree in Windows Explorer -- as you highlight different 
sites, the right pane displays different information.  Notice that the main screen also 
has a Results Log pane at the bottom to provide real-time status of e-mail processing 
and link testing. 

   

      
 2.  Reciprocal Links list organization 

 The right pane of the main screen maintains the Reciprocal Links list associated with 
your highlighted site.  This list has columns of information to give you a quick 
summary of each link.  Notice how it is organized with tabs.  These tabs enable you to 
organize links into the following categories: 

  

•  -- All links associated with the site highlighted in My Sites, irrespective of 
status. 
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•  -- Offer (making an offer or waiting for a response); 

•  -- In-Process (offer accepted, but links not yet implemented); 

•  -- Active (agreed-to links are present when tested); 

•  -- Broken (LinKtoLinK testing reveals that one or more links are no 
longer present or that the server for that website is not responding); 

•  -- Inactive (link is no longer active); and 

•  -- Declined (offer was refused). 

·   

 Click on the  tab and notice that the sample link entries disappear.  Next 
press the  tab and see them reappear.   This is because the active tab displays 
only the links corresponding to its status.  Now click the  tab and all links 
associated with the highlighted site appear, irrespective of status. 

  

 Notice that the Inactive and Declined categories are presently without tabs.  Remove 
the check in the "Hide Inactive & Declined Tabs" check box and notice that these tabs 
appear.  From the All tab you can see an additional link, LinKtoLink.  It was in an 
inactive status so it did not appear until the Inactive and Declined tabs were displayed. 

  

 Highlight the LinKtoLinK entry and press the  button at the bottom 
of the Link list.  A pick list appears.  Double click on "Declined" to change the status 
of the LinKtoLinK entry.  Notice that the Status column now shows a down thumb 
icon for LinKtoLinK.  Now click on the "Hide Inactive & Declined Tabs" check box 
to again remove those links with an Inactive or Declined status. 

   

  
 3.  Site Properties tour 

 Now turn your attention back to My Sites list.  LinKtoLinK maintains key information 
about your websites in order to make informed reciprocal link offers and to test for the 

presence of agreed-to links.  You can get to these properties by clicking on  at the 
bottom of Sites pane or by double clicking on the desired site entry itself.  Perform 
either of these operations now to see the properties that belong to "My Site." 

  

 In the first tab, called "General Info," notice the rich set of information that is present.  
Much of it can automatically be included in your e-mail messages via field tags that 
serve as placeholders for these data fields in the e-mail templates which you can 
customize.  Notice which fields have red titles.  They are mandatory properties which 
each site must have. 

  

  To minimize repetitious data entry, over half of the information in this 
tab can be defined as default information in the "Program Defaults" tab of 
Program Options and thus automatically transferred when a new site is 
created. 
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 Now click on the "E-Mail Assignments" tab.  Here can assign custom e-mail templates 
for messages sent representing this site.  Initially the 8 available messages are assigned 
to the default template for each of these message types, but in the e-mail template 
service you can change existing templates and create new ones. 

  

 Now click on the "HTML/Instructions" tab (LinKtoLinK Pro only).  Here you can 
share HTML code and special instructions with fellow webmasters in your e-mails 
through field tags that correspond to these fields. 

  

  Notice the  and  buttons at the right top corner of the properties 
screen.  These buttons can take you to the properties of other sites in My Sites list. 

  

  Press the Cancel button to return to the main screen. 
   

  
 4.  Link Properties tour 

 LinKtoLinK maintains key information about the reciprocal links associated with each 
of your websites in order to make informed reciprocal link offers and to test for the 

presence of agreed-to links.  You can get to these properties by clicking on  at the 
bottom of Links pane or by double clicking on the desired link entry itself.  Perform 
either of these operations now to see the properties that belong to "Reciprocal 
Website." 

  

  In the first tab, called "General," notice the rich set of information that is present.  
Much of it can automatically be included in your e-mail messages via field tags that 
serve as placeholders for these data fields in the e-mail templates which you can 
customize.  Notice which fields have red titles.  They are mandatory properties which 
each reciprocal link must have. 

  
  Notice that the bottom of this tab contains Test Result information and the date of the 

successful link test (if any).  This is where you can find the details about any failures 
that might have occurred the last time a link test was run and be reminded of the last 
time the links worker correctly. 

    

 Now click on the "Comments/Instructions" tab.  Here is where you can put special 
comments about your interactions with this site's webmaster.  These notes can serve as 

journal entries for any purpose you choose.  A  appears in the Note column of the 
Reciprocal Link List whenever you have made an entry here. 

  

  Notice the  and  buttons at the right top corner of the properties 
screen.  These buttons can take you to the properties of other links in Reciprocal Links 
list. 

   
 Press the Cancel button to return to the main screen. 
   

  



   LinKtoLinK User’s Guide                                                                                                  Page 14 of 94 
 

 5.  Program Options tour 

 The Program Options service enables you to tailor the many LinKtoLinK options to 

meet your needs.  Click on the  button in the toolbar to go there now. 
  

 In the first tab, called "General," notice the variety of options you can select.  Review 
them and pick those that fit your needs. 

  

 Now click on the "Program Defaults" tab.  Here is where you enter the e-mail settings 
and server settings that are typically common across all of your websites.  Information 
placed here is automatically entered into the properties of any new site that you create. 

  

 Now click on the "Message Types" tab (LinKtoLinK Pro only).  Here is where you can 
assign new message titles.  This makes it possible for you to create 8 unique message 
types for use with webmasters of reciprocal sites. 

   

 Press the Cancel button to return to the main screen. 
   

   
 6.  E-Mail Template tour 

 The E-mail Templates service enables you to create as many templates as you want for 
each of the 8 e-mail message types.  In fact, you can create a special template for every 
one of your websites if you wish. 

  

  Click on the  button in the toolbar to go there now. 
   
 On entering the E-mail Template service, the Template Type list box drops down for 

your selection.  This is so that LinKtoLinK knows immediately the type of template 
you want to create or modify.  Select "Initial Offer" as the template type and then 
"Default" for the Template Name. 

  

 Study the structure of this template.  It has been made generic to fit a broad range of 
users.  Notice the use of field tags, such as <<MySiteName>>.  In this case, 
<<MySiteName>> will be replaced by the site title given in its site properties. 

  

  Edit the text appropriately more correctly fits your default needs.  Notice that you can 

insert additional field tags using the  button.  Press  in the toolbar 

when you want to save your changes.  (Alternately, you can press  and save the 
template with a different name.) 

  

 Notice that you can even attach files using the  button.  This could be 
useful in later e-mails for providing a graphic image. 

  

 Select the other template types and modify their default template in a similar manner. 
  

 Press the Cancel button to return to the main screen. 
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 7.  Preview E-mail service 

 The Preview E-mail service enables you to review each message that is tagged for e-
mailing so that you can be confident that exactly what you want will be sent. 

  

 We will start by assigning e-mail messages to the two sample links.  Highlight 
"Reciprocal Website" in the Reciprocal Links list on the main screen and press 

 .  When the pick list appears, select "Initial Offer."   
  

  Highlight "Bad Link Example" and repeat the above operation to assign an "Initial 
Offer" message to it. 

  

 Now click on the  button in the toolbar to begin the previewing the e-mails.  
Notice that the message to be sent to "Reciprocal Website" not longer has any field 
tags; they all have been replaced with data in the site and link properties. 

  

 Click the OK-button to accept the e-mail message as is.  Note that the message is not 
sent; its checkmark  just remains in place in the Reciprocal Link list. 

  

 The "Bad Link Example" message is now previewed.  In this case, press the Do Not 
Send-button.  In this case, the checkmark will be changed to a flag  and will not be 
send when the Send E-mail service is requested. 

  

  Continue previewing messages until you are back to the main screen. 
  

  The preview service will cycle through all e-mails that have a  or a  in the E-
mail column in any of your sites, not just the currently highlighted one! 

   

  
 8.  Send E-mail service 

 The Send E-mail service connects you to your SMTP Internet e-mail account as 
specified in site properties and sends the assigned message for those reciprocal links 
with a checkmark  in the E-mail column.  The checked reciprocal links may be from 
any of your sites -- it does not have to be the currently highlighted one! 

  

 You must have an active SMTP Internet e-mail account to send e-mail messages.  
(SMTP means a Simple Mail Transfer Protocol.)  Note that America On Line (AOL) 
has a proprietary network which may not permit you to send e-mails using 
LinKtoLinK.  With AOL you may have to cut and paste messages from the e-mail 
template screen then manually edit and use AOL's e-mail service.  

     
 Before we can start this example you need to change e-mail address and server 

information.  Highlight "My Site" and double click on it to bring up its properties 
screen.  Put in your precise address in the E-Mail Address text box.  Also change the 
Webmaster, E-mail Sender, and E-Mail Signature fields so that it fits you. 

  

 Now put the name of your Internet SMTP e-mail server in the Host field.  Contact 
your Internet Service Provider if you do not know what it is.  Typically it will be the 
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text following the "@" symbol in your Internet address.  Finally, click the OK-button 
to return to the main screen. 

  

 We also need to change the reciprocal link information so that you can receive the 
message yourself as a test.  Highlight "Reciprocal Website" in the link list and double 
click on it to bring up its properties.  Put in your address in the E-Mail Address text 
box just as you previously did in "My Site" properties.  Finally, click the OK-button 
to return to the main screen. 

   

 The "Reciprocal Website" should have a checkmark  in its E-mail column from Step 

7 of this tutorial; if not, put one there using the  button. 
  

  Now click on the  button in the toolbar to begin sending your e-mail.  If you are 
not already connected to the Internet,  LinKtoLinK will attempt to connect you using 
your Windows Internet dial-up capability in order to send your sample e-mail.  (If for 
some reason this fails, try connecting into the Internet manually and repeat the send e-
mail command.)  Check the progress being made to send your message on the Results 
Log of the main screen. 

   

 Once your message has been sent, take a look at the Reciprocal Links list.  There is no 
longer a checkmark in the E-mail column of "Reciprocal Website" and its Offers 
column now shows a "1" (or one number greater than before if you have previously 
sent offers to this reciprocal site). 

  

 Now use you regular e-mail service and see if you got the sample LinKtoLinK 
message.  If you did, congratulations, you now can be assured that your LinKtoLinK e-
mails will be properly sent to those you specify in link properties.  If you did not 
receive the e-mail message, double check the e-mail addresses and SMTP host name 
you inserted in the site and link properties -- make the appropriate changes and try 
again. 

   

  
 9.  Test Links service 

 This service tests the link information as specified in the site and link properties.  The 
tests will include, if available: 

  

• Your link on someone else's link page; 

• Your image, such as a banner or icon, on someone else's link page; 

• The reciprocal link on your link page; and 

• The reciprocal image, such a banner or an icon, on your link page.  

  These tests will be performed on those reciprocal links with a checkmark  in the 
Test column.  The checked reciprocal links may be from any of your sites -- it does not 
have to be the currently highlighted one! 

  

 You must have an active Internet account and be using Internet Explorer 4.0+, 
Netscape 4.0+, or AOL Browser 4.0+ as your default browser.  (Contrary to the e-mail 
situation, the Test Links service works fine on AOL using their version 4.0 browser.) 
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 The sample data includes appropriate link information so we can perform actual link 
tests.  Highlight "My Site" and double click on it to bring up its properties screen.  
Notice the entries in the Home Page URL, the Link Page URL, and the Image File 
Name text boxes.  Press the Cancel-button to exit back to the main screen. 

  

 Now highlight "Reciprocal Website" in the link list and double click on it to bring up 
its properties.  Notice its Home Page URL, Link Page URL, and Image File Name 
entries as well.  These three fields of information from site properties and from link 
properties tell where the links will be tested (the specified link pages); what links will 
be tested (the specified home pages); and what images will be tested (the specified 
image files).  Press the Cancel-button to exit back to the main screen. 

 

   To start the process, you first need to identify which links to test.  Highlight 
"Reciprocal Website" in the Reciprocal Links list on the main screen and press  

 .   This causes a checkmark  to be place in the Test column of 
"Reciprocal Website."  Repeat this same process so that "Bad Link Example" also has 
a checkmark in the same place. 

  

  If you wanted to check entire groups of links having the same status, you 

could press the  button. 
  

  Now click on the  button in the toolbar to begin link testing.  If you are not 
already connected to the Internet,  LinKtoLinK will attempt to connect you using your 
Windows Internet dial-up capability.  (If for some reason this fails, try connecting into 
the Internet manually and repeat the test.)  Check the progress being made to send your 
message on the Results Log of the main screen. 

  
 Once the tests are complete, take a look at the Reciprocal Links list.   There should no 

longer a checkmark in the Test column of "Reciprocal Website" and of "Bad Link 
Example."  In addition, "Reciprocal Website" should now have a  icon in its Status 
column and a  icon in its Results column.  These indicators tells you that its 
specified links were successfully found in the last link test and consequently 
LinKtoLinK automatically moved it to active link status.   

  
  Similarly, "Bad Link Example" has a  icon in its Results column, signifying that it 

failed the last link test.  Double click on "Bad Link Example" and see under Test 
Results the precise link failures.  (If this link were already in an active status, 
LinKtoLinK would also have moved it to broken link status.) 

   

  
10. Suggested strategy for putting in your information into LinKtoLinK  

 We recommend that you transform "My Site" into your first website if you were 
successful in sending e-mails in step 8.  Highlight "My Site" and right click on it.  In 
the menu that drops down, select "rename" and change the name of this site to your 
website name.  Now double click on it and put your property information in the text 
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boxes. 
  

 You can also transform the sample reciprocal links by double clicking on them and 
putting appropriate information in their properties screen. 

  

 Now enter appropriate site property information in the Program Options "Program 
Defaults" tab.  Put only that information which will generally stay the same for each 
site you add.  This information will automatically be transferred each time to your new 
sites -- this can be a great time saver! 

  

 Add a new site using the  button and complete its property information.  Then add 

any existing reciprocal links using the  button.  Change the status on these existing 
links to "Active."  As necessary, change the e-mail templates to fit the circumstances 
of this site. 

  

 Repeat the previous step until each of your sites has been added. 
   
 Now begin researching other websites that you would like to mutually link to and add 

them accordingly to the link list, keeping them in the default  status.  As you 

get responses to your e-mails, use the  button at the bottom of the 

Reciprocal Links list to move them to their new status; typically,  , 
 , or  . 

 

 Use the Link Harvest Wizard to capture link information and add new entries to 
your reciprocal link lists.  This is a good way to put your existing link page 
information into LinKtoLinK!  (Only available in LinKtoLinK Pro.) 

 

 Use the Export Links service to create your first categorized link page and to later 
update it by cutting and pasting the HTML code of the new links using a HTML 
editor.  (Only available in LinKtoLinK Pro.) 
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Finding Appropriate Websites for Link Sharing  
  

Here are some tips to help you find appropriate websites for link sharing. 

√√ Treat your link page as important real estate which should be attractive to web 
visitors and to fellow webmasters as well.  Will webmasters be interested in exchanging 
links if your "Cool Links" page (or "Related Links page) is disorganized and filled with 
a potpourri of links that make no sense?  Make your link page attractive and well-
organized with easy access throughout your website.  A paraphrase of the golden rule as 
applies very well here:  Make your link page as interesting, as attractive, and as 
organized as you would want the reciprocal link page to be for your link! 

√√ Thoroughly research each candidate reciprocal website.  Typically keep the number 
of links on a link page to a maximum of 50 to 100.  Will this candidate fit well within 
these numbers?  Check each candidate site for evidence of freshness (recent updates 
etc.) and graphic quality -- you want to associate yourself with quality links where 
visitors are motivated to return time and time again. 

√√ Associate your site with sites that draw similar visitors.  Do not waste your precious 
link page space on sites that are unlikely to be interested in your product, service, or 
message. 

√√ Use Search Engines to find reciprocal link candidates.  Look at the links that come 
up when you enter keywords related to your website. 

√√ Check out sites in Yahoo.com's hierarchical listings that relate to your site.   Start at 
Yahoo's home page and walk down its various category paths looking for topics and 
themes that would attract your kind of visitors. 

√√ Check out the link pages of candidate sites for other candidates.  Capitalize on the 
research already accomplished by like-minded fellow webmasters! 

√√ Check out the link pages of competitor sites for other candidates.  Why not use the 
hard work of your competitors to your advantage? 

√√ Offer to exchange graphic links.  For high quality sites, suggest the exchanging of 
banners or graphic buttons on your link pages to motivate visitors to come to your site 
over others. 

√√ Continue promoting your site via search engine submissions, formal banner exchange 
programs, and news group discussions.  The more traffic you have, the more fellow 
webmasters will want to exchange links! 
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Screen Features 
LinKtoLinK has many screens to serve your needs.  Each of the following screens are 
described below:  LinKtoLinK Tips, Main Screen, Link List Tabs, Site Properties, Link 
Properties, Set Links for Testing, Customize Link List, Import Links, Export Links, E-Mail 
Template, Check Spelling, User Dictionaries, Spelling Checker Options, Preview E-Mail 
Service, Backup/Restore Database, Modify Link Categories, Program Options, Site Report 
Dialog, and Print Setup. 

  
LinKtoLinK Tips  

LinKtoLinK Tips are presented at startup to help you learn its features and to provide 
productivity suggestions.  By default the Tips screen is shown at startup.  You can turn 
of this startup presentation from the tips screen itself or from the Help menu. 

 
 

Here are the features of the Tips screen: 

Tip Display -- Gives a random tip in categories such as,  "Did you know...";  "Have you..."; 
and "Shortcuts to save you time..." 

Show Tips On Startup -- Use the check box if you wish to no longer receive Tips at 
program startup. 

Next Tip >> Button -- Provides the next randomly generated tip.  Use this to cycle through 
the tips and see if you know all the information that is being presented! 

Close Button -- Exits you from the Tips screen. 

More Info Button -- Takes you to a related topic in the Help System. 
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Main Screen 

On entry, LinKtoLinK goes to the main screen.  It is the central control center for 
managing your reciprocal links.  From here, you can create a record about each of 
your websites and then assign the reciprocal links that go with it.  It has a similar look 
to Windows explorer. 

 
  The main screen is organized from top to bottom as follows: 

 1. Top Section 
 2. My Site List Pane  
 3. Reciprocal Links List Pane 
 4. Results Log Pane  
  
1. Top Section 

The top section consists of a title bar, menu bar, and a toolbar. 

   The site currently highlighted in the My Site pane is displayed in brackets within 
the titlebar. 
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The toolbar provides a quick way to launch the following frequently-used services: 

 

 

 preview e-mail, send e-mail, test links, stop link testing or e-mail sending, e-mail 
templates, program options, and help for the main screen (this help screen). 

  

   Right click on the toolbar and you get a choice to use small, medium, or large 
icons in the toolbar. 

  

  Right click on the LinKtoLinK icon to the right of the toolbar and the program will 
attempt to connect you to the Internet (if necessary) and take you to the LinKtoLinK 
website. 

  

    
2. My Site List Pane 

My Sites Display -- A list of your sites appears here.  It is situated on the left side of the 
main screen similar to the directory list in Windows Explorer.  Following the Explorer 
model, the pane on the right changes as you select different sites in My Sites list.  It shows 
the links that are associated with your selected site. 

My Sites toolbar is located below My Sites Display.  It contains the following four buttons: 

New -- Asks you for a new site name and then opens a site properties screen so you can 
add a new site to "My Sites" list. 

Edit -- Opens the site properties screen of the currently highlighted site in "My Sites" 
list so that you can edit it. 

Copy -- Makes a copy of the currently highlighted site in "My Sites" list giving it the 
name "Copy of ..." 

Delete -- Permanently removes the currently highlighted site in "My Sites" list and all 
its corresponding links. 

  

 Instead of using the My Sites toolbar,  you can right click on a highlighted site.  This 
will display a dropdown menu with the same services plus a site rename function.  

 To edit the properties of a site, just double click on it. 

  The free unregistered version of LinKtoLinK permits you to enter and manage the reciprocal links of one 
of your sites.  By registering LinKtoLinK, you can enjoy all of its  Pro features including the ability to manage 
an unlimited number of sites. 
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3. Reciprocal Links List Pane 

Reciprocal Links Display -- Shows the list of reciprocal links that are associated with your 
currently highlighted site.  Like Windows Explorer, it is organized into a series of data 
columns: 

E-mail -- Shows a check whenever you use the Set E-mail button to assign an e-mail 
message to that link.  A check mark means that the assigned message will be sent 
the next time that the send e-mail service is used. 

   A yellow flag appears in the E-mail column when you preview an e-mail and press 
the Do Not Send button.  This alerts you that there is something wrong with the e-
mail message.  It will not be sent until this flag is cleared and replaced by a check. 

  

Test -- Shows a check whenever you use the Set for Test button to flag a link.  A 
check mark means that the link will be tested the next time the test links service is 
used. 

Website -- Shows the name of the reciprocal link website. 

Home Page -- Shows the name of the reciprocal link home page. 

Offers -- Shows the number of times an offer for exchanging reciprocal links has been 
made.  This number increments every time an offer-type e-mail is sent; e.g., an 
initial offer or a repeat offer. 

Status -- Presents an icon depicting the current status of the link; either as "Offer," "In-
Process," "Active," "Broken," "Inactive," or "Declined."  The icons are the same as 
shown on the tabs above the Link List. 

Results -- Shows link test results.  A green ball indicates that the last test was fully 
successful.  A red ball indicates that the last test was not fully successful.  These 
icons are cleared when another link test is started. 

Note -- Shows the notepad icon  whenever the Comments field of link properties 
contains an entry. 

   Looking for a  in the Note column of the Reciprocal Link List is the 
fastest way to see where you have made comments or journal entries about 
that reciprocal link. 

  

  A fast way to sort the Link List is to click on a title button located above the list.  
This will sort the list alphabetically based on the column selected.  (Note the Results 
column and the Note column cannot be sorted.) 

  

     You can change the Link List using customize link list service in the Links menu 
(LinKtoLinK Pro only).  

   

  To simplify the Link List display, the tabs showing those links that are Inactive or 
Declined are initially hidden.  The next setion gives detailed information on how these 
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tabs work. 
  

  The number of links in the current view are shown in red at the top of the 
Reciprocal Links list.  This helps you know the size of the list when it exceeds the size 
of the window pane. 

  

Reciprocal Links toolbar is located below the Reciprocal Links Display.  It contains the 
following eight buttons: 

New -- Opens a new link properties screen so you can define a reciprocal link for the 
active, or highlighted, site in "My Sites" list. 

Edit --  Opens the link properties screen of the currently highlighted link in the 
Reciprocal Link list so that you can edit it. 

Delete -- Permanently removes the currently highlighted link in the Reciprocal Link 
list. 

  

Set E-mail -- Opens a pick list so that you can select the desired message to send about 
the currently highlighted link.  Selecting a message also leaves a check in the E-mail 
column of the link so that the message will be sent the next time the Send E-mail 
service is used. 

  Clicking the Set E-mail button while the higlighted link is already checked for 
sending e-mail will clear the check mark rather then open the message pick list. 

  

Set for Test -- Checks the Test column of the link that is currently highlighted.  
Clicking this button a second time will uncheck the column. 

Set Multiple Tests -- Opens a special dialog box where you can select (or unselect) all 
links of a particular status, such as all active ones, for link testing. Your selections 
are denoted with a check in the Test column of the link list.  You can select to test 
links at all sites or at just the currently active site via a special check box in the pick 
list. 

Change Status -- Opens a pick list so that you can change the status of the currently 
highlighted link. 

Legend -- Opens the help system to a legend showing the meaning of each icon used in 
the Reciprocal Links List. 

  

 A number of the above operations can be applied to multiple rows.  Here are some 
examples: 

     

   To delete a range of links, click on the first row to be deleted, hold down the shift-key 
and click on the last row, and then press the Delete-button.  

  
  To flag a set of links for testing, hold down the ctrl-key and click one at a time on the 

rows you want to test, and then press the Set for Test-button. 
     



   LinKtoLinK User’s Guide                                                                                                   Page 25 of 94 

 Instead of using the Links toolbar to make changes to the reciprocal links list, you can 
right click on a highlighted link or set of highlighted links.  This will display a dropdown 
menu with the same services plus sorting the link list and customizing the list. 

 Another way to delete a set of highlighted links is to press the Delete-key on the 
keyboard.  Similarly, pressing the Insert-key while the Links pane is active will add a new 
link. 

 To edit the properties of a link, just double click on it. 

  
4. Results Log Pane  

Results Log Display -- Provides real-time status of e-mail processing and link testing. 

   Use the Results Log display to watch the progress in LinKtoLinK in sending e-
mails and testing links. 

  

  Use the Include URL in results when testing links check box if you want to see 
complete Internet addresses in the results log.  Typically you will leave this box 
unchecked, and use it only to spot problems; such as misspelling a URL address. 

  

Results Log toolbar is located above the Results Log Display.  It contains the following 
three buttons: 

Save -- Enables you to save a result log that is currently being displayed..  You may 
specify any filename you wish.  This file can be opened by Windows Notepad or 
Windows Wordpad. 

  LinKtoLinK will automatically empty the Results Log when it exits.  You the save 
button if you want to retain this information. 

  

Print -- Enables you to print the result log that is currently being displayed. 

Clear -- Removes all information in the results log. 

   LinKtoLinK will automatically clear the Results Log each time it tests links or 
sends e-mail if the check box for this function is checked in program options . 
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Link List Tabs (Link Status) 

The tabs in the Reciprocal Links pane of the Main Screen enable you to organize links 
into status categories. 

     
  

Here are the link status categories: 

√√  -- All links associated with the site highlighted in My Sites, irrespective of status. 

√√  -- Offer (making an offer or waiting for a response); 

√√  -- In-Process (offer accepted, but links not yet implemented); 

√√  -- Active (agreed-to links are present when tested); 

√√  -- Broken (LinKtoLinK testing reveals that one or more links are no longer 
present or that the server for that website is not responding); 

√√  -- Inactive (link is no longer active); and 

√√  -- Declined (offer was refused). 

 Clicking on a tab will show the links which have that particular status. 
  

  To keep your Main Screen as uncluttered as possible the Inactive and Declined 
status tabs are initially hidden:  

   

  
 

 Whenever you want to view information about inactive links or declined offers, just 
remove the check from the check box shown above. 

 

  
Legend for Reciprocal List 

For reference here are the many symbols used in the reciprocal list, column by 
column: 

  
E-Mail Column 

  -- Set for e-mail (set to send selected message to webmaster of site) 
 -- Do Not Send (selected during e-mail preview) 

  
Test Column 
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 -- Set for Test (set to test the links of this site based on test rules in My Sites 
properties) 

  
Status Column -- identifies the status of the corresponding website. 

 -- Offer Status (making an offer or waiting for a response); 
 -- In-Process Status (offer accepted, but links not yet implemented); 
 -- Active Status (agreed-to links are present when tested); 
 -- Broken Status (LinKtoLinK testing reveals that one or more links are no 

longer present or that the server for that website is not responding); 
 -- Inactive Status (link is no longer active); and 
 -- Declined Status (offer was refused). 

 

 The Inactive Status and Declined Status symbols will only appear if the "Hide 
Inactive & Declined Tabs" checkbox is not checked. 

 
Results Column -- shows the results of the last link test in accordance with the test 
rules defined in my sites properties. 

 -- Test Fully Successful 
 -- Failed to Find One of the Websites (it could be that the website is no longer 

active or that the web server is down) 
 -- Website Found, But Specified Link Missing 

  
Note Column 

 -- Comment Present (you will find text under the comment tab of the site 
properties)  

 
Site Properties 

The Site Properties screen maintains information on each of your sites.   The easiest 
way to access the properties of one of your sites is to double click on it.  This properties 
screen is organized into three tabs:  

       1. General Information 
 2. E-mail Assignments 
 3. Test Rules 
 4. HTML/Instructions 

Buttons available from all tabs are listed at the bottom of this section. 

  
1. General Information Tab 

This tab maintains general site information and server information. 
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  Site Information 

Site Title (required) --  Enter your site name in the text box.  (The <<MySiteName>> 
tag field in an e-mail template is replaced with the information stored here.) 

  You may wish to add additional text to your site title in order to have a number of 
site listings of the same site, but with different e-mail templates and other settings; 
such as:  

 My Site X -- Standard Offer 
 My Site X -- Banner Offer  
 My Site X -- FFA Links 

  

Site Description -- Enter a description of your site in the multiple line text box.  (The 
<<MySiteDesc>> tag field in an e-mail template is replaced with the information 
stored here.) 

Home Page URL (required) -- Enter the full Internet address of your site's home page 
in the text box.  (The <<MyHomepage>> tag field in an e-mail template is replaced 
with the information stored here.) 

IP Address (optional) – If the website may be referenced by its Internet Proc\tocol 
address (IP) address, enter it in this text box. 

Link Page URL -- Enter the full Internet address of your site's link page in the text 
box.  (The <<MyLinkpage>> tag field in an e-mail template is replaced with the 
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information stored here.) 

  Whenever LinKtoLinK asks for a URL address, be sure to give the full Internet 
address starting with "http://..." otherwise it will not work properly. 

  

Image File Name -- Enter the file name of any image you wish to share in the text 
box.  (The <<MyImageName>> tag field in an e-mail template is replaced with the 
information stored here.) 

   When you enter an image file name in site properties, give only the basic file 
name, not the full path name.  LinKtoLinK will search for the presence of this file 
name in the reciprocal site's link page during link testing. 

   
Webmaster’s Name -- Enter your webmaster's name in the text box.  (The 

<<MyWebmaster>> tag field in an e-mail template is replaced with the information 
stored here.) 

E-mail Address (required) -- Enter your SMTP Internet e-mail address in the text 
box.  This is the address that will be appear when someone replies to one of your e-
mail messages.  (The <<MyEmailAddress>> tag field in an e-mail template is 
replaced with the information stored here.) 

Host (required) -- Enter the name of your SMTP Internet e-mail server in the text box.  
This may be the portion of your a-mail address after the "@" symbol.  If you are not 
sure, try this or query your Internet Service Provider for this information.  Note that 
America On Line (AOL) has a proprietary network which may not permit you to 
send e-mails using LinKtoLinK. 

Port (required) --  Enter the port number of your e-mail server (i.e., your SMTP - 
Simple Mail Transfer Protocol) in the text box.  By default this port number is set to 
25.  Please do not change this number unless you are absolutely sure your e-mail 
service is using a non-standard port. 

E-mail Sender --  Enter your e-mail sender's name in the text box.  This is the name 
that will be identified as the sender in any e-mail messages. 

E-mail Signature --  Enter your signature block in the multiple line text box.  (The 
<<MySignature>> tag field in an e-mail template is replaced with the information 
stored here.)  

 Use the web browser buttons  to the right of the Home Page and Link Page text boxes 
to view the specified Internet addresses.  Pressing these buttons will launch your default 
Internet browser and take you to the specified address.  This is an easy way to quickly get to 
the home page or link page of your website. 

  HTTP Server Information  

Proxy -- Enter the name of your proxy server in the text box.  By default this field is 
left blank.  Please do not enter anything here, unless you know that a proxy server is 
being employed. 

Port (required) --  Enter the port number of your HTTP (i.e., your graphical web 
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interface) in the text box.  By default this port number is set to 80.  Please do not 
change this number unless you are absolutely sure your http service is using a non-
standard port. 

 Required entries are displayed in red text. 

    
2. E-mail Assignments Tab 

This tab maintains which e-mail template will be used for each of the eight messages 
that are available for this site. 

 
 

 To change from the default e-mail templates that are initially assigned, create additional 
templates using the e-mail template service and then click on the appropriate dropdrown box 
as shown above and select the desired message template.  

  
3. Test Rules Tab 

This tab controls which link and image tests to perform. 
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Based on which check boxes you select, you can: 

• Test for the presence of your site's link on the link page of every URL in the corresponding reciprocal 
link list. 

o Test for the presence of your site's image on this same link page. 

• Test for the presence of each reciprocal site link on your site's link page. 

o Test for the presence of each reciprocal image on your site's link page. 

  

 The default test rules are to test for the existence of links on both your site and the reciprocal site, but to 
not check for graphical images. 

  
4. HTML/Instructions Tab 

This tab is used to store HTML code and special instructions that you might want to 
provide to a reciprocal webmaster via an e-mail message (LinKtoLinK Pro feature 
only).  
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Text Link HTML --  Enter HTML code about your text link that you want to share 
with the reciprocal webmaster in the multiple line text box.  (The 
<<MyLinkHTML>> tag field in an e-mail template is replaced with the information 
stored here.) 

Image Link HTML --  Enter HTML code about your image link that you want to 
share with the reciprocal webmaster in the multiple line text box.  (The 
<<MyImageHTML>> tag field in an e-mail template is replaced with the 
information stored here.) 

Special Instructions --  Enter special instructions that you want to share with the 
reciprocal webmaster in the multiple line text box.  (The <<MySpecialText>> tag 
field in an e-mail template is replaced with the information stored here.) 

  
General Buttons 

  Top of screen 

 Button -- Takes you to the properties of the previous site in the database. 

 Button --  Takes you to the properties of the next site in the database. 

  These buttons are only used in the Pro version since the unregistered free version 
applies to only one of your sites.  
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  Bottom of screen 

Help Button -- Takes you to this help screen. 

OK Button -- Implements any changes you have made to this screen and returns you 
to the main screen. 

Cancel Button -- Cancels any changes you have made to this screen and returns you to 
the main screen. 

Apply Button --  Implements any changes you have made to this screen. 
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Link Properties 

The Link Properties screen maintains information on the reciprocal links associated 
with each of your sites.  The easiest way to access the properties of a particular link is 
to double click on it.  This properties screen is organized into two tabs:  

 1. General  
 2. Comments/Instructions 

Buttons available from all tabs are listed at the bottom of this section. 

  
1. General Tab 

This tab maintains general link information plus test results and e-mail selection 
information.  

    
 

  Link Information 

Title (required) --  Enter the reciprocal link in the text box.  (The 
<<RecipSiteName>> tag field in an e-mail template is replaced with the information 
stored here.) 

Description -- Enter a description of the reciprocal link in the multiple line text box.  
(The <<RecipSiteDesc>> tag field in an e-mail template is replaced with the 
information stored here.) 

Home Page URL (required) -- Enter the full Internet address of the reciprocal link's 
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home page in the text box.  (The <<RecipHomepage>> tag field in an e-mail 
template is replaced with the information stored here.) 

IP Address (optional) -- If the link may be referenced by its Internet Protocol (IP) 
address, enter it in this text box. 

Link Page URL -- Enter the full Internet address of the reciprocal link's link page in 
the text box.  (The <<RecipLinkpage>> tag field in an e-mail template is replaced 
with the information stored here.) 

  Whenever LinKtoLinK asks for a URL address, be sure to give the full Internet 
address starting with "http://..." otherwise it will not work properly. 

  

Image File Name -- Enter the file name of any image you wish to share in the text 
box.  (The <<RecipImageName>> tag field in an e-mail template is replaced with 
the information stored here.) 

   When you enter an image file name in link properties, give only the basic file 
name, not the full path name.  LinKtoLinK will search for the presence of this file 
name on your associated site's link page during link testing. 

  
Link Category -- Use the dropdown list box to indicate the category of this reciprocal link.  

(LinKtoLinK Pro only.)  

 Link category can be added as a column to reciprocal link list screens and used as a sort field to 
help you better organize your list.  A links page generated by the Export service can also be organized 
by the link categories.  (LinKtoLinK Pro only.)  

 

 Link categories are defined in the "Modify Link Categories" service under the Tools menu.  
(LinKtoLinK Pro only.) 

 

Webmaster -- Enter the name of the reciprocal link webmaster in the text box.  (The 
<<RecipWebmaster>> tag field in an e-mail template is replaced with the 
information stored here.) 

E-mail Address -- Enter the e-mail address of the reciprocal link in the text box.  This 
is where any e-mail messages to the reciprocal link will be sent.  (The 
<<RecipEmailAddress>> tag field in an e-mail template is replaced with the 
information stored here.) 

 Use the web browser buttons  to the right of the Home Page and Link Page text boxes to 
view the specified Internet addresses.  Pressing these buttons will launch your default Internet 
browser and take you to the specified address. This is an easy way to see what you link looks 
like or to collect additional information about the web page.  
 

  Test Results 

Current test status --  Shows the results of the most recent link test in the multiple 
line text box. 

Date of last successful test -- Shows the date, if one exists, of the last fully successful 
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test of this link. 
  

Select Next E-Mail --  Shows the type of message that will next be e-mailed and enables 
you to change the message through the dropdown list box.  (Note:  changing to a different 
message has no effect on the e-mail column of the main screen .) 

 

  Required entries are displayed in red text. 

  
2. Comments/Instructions Tab 

This tab stores journal information about the reciprocal link. 

   

 

Insert Date/Time Stamp button -- Place the current date and time on the line below the last 
line.  

Comments -- Place your comments in this multiple line text box. 

 Use the comments tab in Link Properties to document special issues regarding this 
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reciprocal link or to maintain journal information that does not fit in the other link database 
fields.  

   
General Buttons 

  Top of screen 

 Button -- Takes you to the properties of the previous reciprocal link in the 
database. 

 Button --  Takes you to the properties of the next reciprocal link in the 
database. 

   
  Bottom of screen 

Help Button -- Takes you to this help screen. 

OK Button -- Implements any changes you have made to this screen and returns you 
to the main screen. 

Cancel Button -- Cancels any changes you have made to this screen and returns you to 
the main screen. 

Apply Button --  Implements any changes you have made to this screen.   

  
Set Links for Testing 

This dialog box appears whenever the "Set Multiple Tests" button is pressed on the 
main screen.  It enables you to quickly select (or unselect) for testing all the links of a 
particular status. 

 

Top of screen  

Status Section -- Use the check boxes here to designate which status types to select (or 
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unselect) for testing. 
  

Bottom of screen 

Include all sites -- Use this check box to instruct LinKtoLinK to select (or unselect) 
links across all sites, not just the currently highlighted one. 

Help Button -- Takes you to this help screen. 

Select Button -- Selects for testing all links that meet the conditions that are checked 
and returns you to the main screen. 

Unselect Button -- Unselects for testing all links that meet the conditions that are 
checked and returns you to the main screen. 

Cancel Button -- Cancels your work and returns you to the main screen. 

  
Customize Link List  

This dialog box appears whenever the "Customize Link List" operation is requested.  
It enables you to add and remove columns in the Reciprocal Link List of the main 
screen and to reorder them to your choosing. 

 
  

The top of screen is organized into two list boxes:  "Available Fields" and "Current 
Fields." 

To add additional columns to the Link List -- Highlight the desired columns in the 
Available Fields list box and press the > button. 

To remove columns from the Link List -- Highlight the desired columns in the 
Current Fields list box and press the < button. 

To change the order of the columns in the Link List -- Highlight the column you 
wish to move in the Current Fields list box and press the Up button or the Down 
button to move it, accordingly. 

  To move a range of fields from one list box to the other, click on the first field to 
be moved, hold down the shift-key and click on the last field, and then press the the > 
button or the < button, accordingly.  (The ctrl-key works similarly to select and 
move a set of fields.) 
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Bottom of screen 

Help Button -- Takes you to this help screen. 

Default Button -- Updates the Current Fields list box with the default columns in their 
original order and removes any optional columns. 

Apply Button --  Implements any changes you have requested to the Link List and 
returns you to the main screen. 

Cancel Button -- Cancels any changes you have made and returns you to the main 
screen. 

  

  The Customize Link List operation can be initiated from the Links menu or by right 
clicking on a link in the Reciprocal Link List.  It is only available in LinKtoLinK Pro.  

  
Import Links 

The Link Harvest Wizard enables you to collect link data from a specified webpage, 
then to review the links gathered, and finally to add the links you want to one of your 
reciprocal link lists.  Press "Import Links" within the File Menu found on the main 
screen.  

 
There are 5 steps to using the Link Harvest Wizard: 

1.  Specify your site where the links are to be imported into and the Internet address that 
contains the links to be harvested.  Press the Next> button to proceed. 

 

 Use the web browser button  to the right of the link URL text box to view the 
specified link page. 

 

2.  Select whether or not to filter out links containing the same base URL or to filter out 
duplicate links.  Again, press the Next> button to proceed. 
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 Generally you will want to filter out links containing the same base URL as they are 
most likely internal website references rather than useful additional links. 
 

3.  Review the import instructions that you gave the Wizard.  If they are correct, you 
will press the Next> button.  If they are not correct, you will press the <Back or the 
Cancel button. 

 

 

4.  Review the list of links that are found at the specified address.  If you want to keep 
the link, leave the check in the check box..   If you do not want a certain link, click its 
check box to unselect the link.  Press the Next> button to proceed. 
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Then press the Finish button to go to the Main Screen. 

 

 

5.  At the Main Screen, see that the links you picked have been added to your reciprocal 
list. 
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Edit the link properties of each new link appropriately.  Typically, you will want to add 
the website title and the webmaster's email address as well as other relevant 
information. 
 

 To help gather this information, press the web browser button  to the right of the 
Home Page text box in the General Tab of Link Properties.  It will launch your default 
Internet browser and display the specified website. 
 

 The Link Harvest Wizard will add a comment in the properties of each link it 
generates indicating the date of creation. 
 

 If you already have an existing links page, the Link Harvest Wizard is a great way 
to capture that basic link information and build your initial reciprocal link list! 

  
Export Links 

The Export Links service generates a simple link page in HTML of the active links 
present in the current reciprocal link list.  You can use the link page file directly in 
your website or cut and paste the appropriate HTML code into your existing link page 
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using a HMTL editor, such as FrontPage.  To access this service,  press "Export 
Links" within the File Menu found on the main screen.   

First select whether you want to export all links in the currently displayed reciprocal links 
list or just the ones added since the last time you exported links from this list: 

 
 

Then specify where you want the link page to be stored: 

 
 

Then, view and edit the generated link page: 

 
 

Here's an example of the link page that is generated: 
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 Using the Export Links service, the generated link page will be organized into the 
link categories you have specified in link properties. 

 
E-Mail Templates 

This dialog box appears whenever the "E-mail Templates" button is pressed on the 
toolbar of the main screen.  It enables you to create as many templates as you want for 
each of the 8 e-mail message types. 
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  On entering the E-mail Template service, the Template Type list box drops down 
for your selection.  This is so that LinKtoLinK knows immediately the type of template 
you want to create or modify. 

  

The main screen is organized from top to bottom as follows: 

 1. Menu bar 
 2. Toolbar 
 3. Main Section 
   

  
1. Menu bar 

The menu bar has three main topics:  template, edit, and help. 
  

  Template 

New Template -- Creates a new template.  Once the blank template is presented, 
identify the type of template it is to be: an initial offer, a repeat offer, etc.  Use the 
Template Type dropdown list box in the Header Section to make this selection. 

Open Template -- Opens an existing template by dropping drown the Template Name 
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list box for your selection.  The template names correspond to those associated with 
the message type shown directly above it. 

  

Save Template -- Saves changes to the current template under the name that appears in 
the Template Name list box. 

Save Template As -- Opens a new template name dialog box so you can save the 
currently displayed template under a new name. 

  

Delete Template -- Deletes the template that is currently displayed. 
  

Print -- Prints the template that is currently displayed. 

Print Setup -- Enables you to change printers (if available) and printer properties. 
  

Exit -- Returns you to the main screen. 
  

  Edit 

Attach File -- Opens the file save dialog box so that you can select a file.  This file will 
be attached to any e-mail sent using this template.  

Remove Attachment -- Deletes the attachment assignment.  (The file itself is NOT 
deleted!) 

  

Undo To Last Save -- Restores the current template to the way it was the last time it 
was saved. 

Check Spelling -- Checks the spelling of the words in the subject and the message text 
area. 

  

  Help -- Takes you to this screen. 

 
2. Toolbar  

The toolbar provides a quick way to launch a subset of the services provided in the 
menu bar. 

  

These buttons are:  new template, open template, save template, save template as, undo to 
last save, delete template, check spelling, print, and help.  (Refer to the menu bar above for 
information on each operation.)  

   
3. Main Section 

The main section consists of a header section, a message text area, and a bottom 
section. 

 

  Header Section  

Template Type -- Use the dropdown list box to assign the template to a particular type 
of e-mail message.  Use can assign the template to be any of the following types: 
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• Initial Offer, 

• Repeat Offer, 

• We've added your link, 

• Add our link, 

• We've added your link, please add ours, 

• Our link seems to be broken, 

• Reciprocal links tested successfully, or 

• User defined message. 

  With LinKtoLinK Pro you can change the titles of these 8 message types to better 
suit your needs in Program Options. 

  

Template Name -- Use the dropdown list box to select an existing template that is 
assigned to the template type that is showing. 

Insert Field Tag Button -- Use this button to bring up a pick list of field tags that you 
can insert into the subject or the message text area.  The field tag is placed wherever 
your cursor is situated inside either of these two areas.  When an e-mail message is 
sent, each field tag is replaced with the information stored in the appropriate site 
properties and link properties database.  Here is a list of the available field tags: 

• <<MySiteName>> -- Name of my website 

• <<MySiteDesc>> -- Description of my website 

• <<MyHomepage>> -- URL address of my home page 

• <<MyLinkpage>> -- URL address of my link page 

• <<MyImageName>> -- Name of my image file 

• <<MyWebmaster>> -- Name of my webmaster 

• <<MyEmailAddress>> -- My E-mail address 

• <<MySignature>> -- My signature block 

• <<MyLinkHTML>> -- HTML code about my link text 

• <<MyImageHTML>> -- HTML code about my link image 

• <<MySpecialText>> -- My special instructions 

• <<RecipSiteName>> -- Name of reciprocal website 

• <<RecipSiteDesc>> -- Description of reciprocal website 

• <<RecipHomepage>> -- URL address of reciprocal home page 

• <<RecipLinkpage>> -- URL address of reciprocal link page 

• <<RecipImageName>> -- Name of reciprocal image file 

• <<RecipWebmaster>> -- Name of reciprocal webmaster 
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• <<RecipEmailAddress>> -- E-mail address of reciprocal webmaster  

 

Subject -- Use this text box to enter the subject heading that you want to appear in the 
e-mail. 

  

  Message Text Area 

 Use this multiple line text box  to enter the body of your e-mail message. 
  

  Use the Save Template As button to copy a template close to the one you want to 
create and then modify the copy accordingly.  This is usually faster than starting a new 
template from "scratch." 

  

  Bottom Section  

Attach File Button -- Opens the file save dialog box so that you can select a file.  This 
file will be attached to any e-mail sent using this template.  

  Use the file attachment feature in the E-mail Template service to send banner 
artwork and other related information in follow-up e-mail messages to fellow 
webmasters. 

    
File Information Displays -- Shows information on the file to be attached:   its full 

path file name, its size, and the date of its last change. 

Remove File Button -- Deletes the attachment assignment.  (The file itself is NOT 
deleted!) 

  
Check Spelling  

The Check-Spelling Dialog appears if a word requiring your attention is detected. You 
can use the dialog to specify whether the word should be ignored or replaced.  
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List Boxes: 

Consider Changing box -- Contains a word which may be misspelled or otherwise 
incorrect, and is presented with a candidate replacement word. You can change the 
word by selecting the Change button, or skip it by selecting the Ignore button. Note 
that the label of this box changes to "Not in dictionary" when a misspelled word is 
detected. 

Problem box (Not in Dictionary) -- Contains the misspelled word. The label of this 
box changes with the type of problem detected. Not in dictionary indicates that a 
misspelled word was detected; the word is considered misspelled because it could 
not be located in any open dictionaries. Consider changing indicates a word was 
encountered which was marked with a conditional-change action in a user 
dictionary. Capitalization indicates the word is spelled correctly but needs to be 
capitalized.  

Suggestions list -- Contains a list of suggested replacements for the word reported as 
misspelled. Subsequent presses of the Suggest button may yield more suggestions. 
The word selected in the Suggestions list will be used as the replacement when the 
Change or Change All buttons are pressed, unless the word in the problem box was 
edited. 

Add Words To list -- Indicates which user dictionary words will be added to when 
you select the Add button. The Add Words To list shows all user dictionaries 
currently open. You can also add words to user dictionaries via the  User 
Dictionaries Dialog, which is accessible by selecting the Dictionaries button. 

  

Buttons:  

Ignore button -- Causes this occurrence of a misspelled word to be skipped. If the 
same misspelled word appears later, it will be reported. 

Ignore All button -- Causes this and all further occurrences of a misspelled word to be 
skipped. You might use this button if the word reported as a misspelling is actually 
spelled correctly. If the word is one you use frequently, you may wish to ignore it 
permanently by selecting the Add button. 

Change button -- Causes this and all following occurrences of the reported word to be 
replaced. If the problem word was edited, the edited word is used as the 
replacement. Otherwise, the selected suggestion is used as the replacement. If you 
want only this occurrence of the word to be replaced, use the Change button. If the 
reported word is one you frequently misspell, you might consider adding it to a user 
dictionary via the  User Dictionaries Dialog. You can display the User Dictionaries 
dialog by selecting the Dictionaries button. 

Change All button -- Causes this and all following occurrences of the reported word 
to be replaced with the word in the Change To box. If you want only this occurrence 
of the word to be replaced, use the Change button. If the reported word is one you 
frequently misspell, you might consider adding the misspelling and the correction to 
a user dictionary via the  User Dictionaries Dialog. You can display the User 
Dictionaries dialog by selecting the Dictionaries button. 

Add button -- Causes the reported word to be added to the dictionary selected in the 
Add Words To list. Use the Add button if a correctly spelled word you use often is 
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reported as a misspelling (e.g., your family name). If the word is not used 
frequently, you may want to select the Ignore or Ignore All buttons instead. 

Suggest button -- Search more thoroughly for suggested replacements for the current 
misspelled word. Each time you press the Suggest button, a "deeper" search is 
made. The Suggest button is disabled once all possible suggestions have been 
located. 

Undo button -- Removes the last change made. The Undo button can be pressed 
several times to remove the last several changes. 

Undo Edit button -- Remove any changes made to the text in the problem box. This 
button appears only if the text in the problem box has been changed. 

Dictionaries button -- Causes the User Dictionaries Dialog to be displayed. You can 
use the User Dictionaries dialog to edit the contents of user dictionaries. 

Options button -- Causes the Options Dialog to be displayed. You can use the Options 
dialog to set spelling-checker options. 

Help button -- Takes you to a help screen similar to this. 

Cancel button -- Stops the current spell-checking operation. 
  

This text is Copyright © 1998  Wintertree Software Inc. 

  
User Dictionaries  

The User Dictionaries Dialog allows you to edit the contents of a user dictionary. The 
contents of user dictionaries are saved in disk files. 

  
   

List Boxes:  

Words list -- Contains the list of words in the currently selected user dictionary. 

Other Word box -- Contains an alternate word associated with the currently selected 
word. The other word is used in the "Auto change" and "Conditionally change" 
actions to supply a replacement word. You can enter more than one word in the 
Other Word box, but the total length should be limited to 63 characters. 
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Action list -- Used to select an action which is associated with words in the dictionary. 
The action tells the spelling checker what to do when it finds a word in the 
dictionary. The following actions can be selected: 

• Auto change (use case of checked word) -- This action allows you to 
automatically replace one word with another. For example, if you often type 
"recieve" instead of "receive", you might enter the word "recieve" with "receive" as 
the other word and "Auto change (use case of checked word)" as the action. The 
spelling checker will automatically correct "recieve" wherever it appears. If 
"recieve" was capitalized ("Recieve") the spelling checker would automatically 
replace it with "Receive". Note that the replacement is made automatically only if 
the "Auto Change" option is enabled (see the Options Dialog for information on the 
Auto Change option). 

• Auto change (use case of other word) -- This action allows you to automatically 
replace one word with another, always with the same case pattern as the other word. 
This action is useful for automatically expanding abbreviations. For example, you 
could enter the word "TBD" with "to be determined" as the other word and "Auto 
change (use case of other word)" as the action. The spelling checker will 
automatically replace "TBD" with "to be determined" wherever it appears. Note that 
the replacement is made automatically only if the "Auto Change" option is enabled 
(see the Options Dialog for information on the Auto Change option). 

• Conditionally change (use case of checked word) -- This action allows you to 
optionally replace one word with another. For example, if you often type "recieve" 
instead of "receive", you might enter the word "recieve" with "receive" as the other 
word and "Conditionally change (use case of checked word)" as the action. The 
spelling checker will ask if you want to replace "recieve" with "receive". If 
"recieve" was capitalized ("Recieve") the spelling checker would ask if you wanted 
to replace it with "Receive". 

• Conditionally change (use case of other word) -- This action allows you to 
optionally replace one word with another, always with the same case pattern as the 
other word. This action is useful for optionally expanding abbreviations. For 
example, you could enter the word "TBD" with "to be determined" as the other 
word and "Conditionally change (use case of other word)" as the action. The 
spelling checker will ask if you want to replace "TBD" with "to be determined". 

• Exclude (treat as misspelled) -- This action tells the spelling checker that the word 
is misspelled, even if it is listed in another dictionary. Words marked with this 
action will never be offered as suggestions for misspelled words, and they will be 
reported as misspellings when they are encountered by the spelling checker. 

• Ignore (skip) -- This action tells the spelling checker that the word is spelled 
correctly, and so can be skipped over. This is the most common action. 

User Dictionaries list -- Contains the list of open dictionary files. When you select a 
file from the list, its contents are displayed in the Words list. 

  

Buttons:  

Add Word button -- Causes the word entered in the edit area of the Words list to be 
added to the currently selected dictionary. The currently selected action and other 
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word are associated with the word. You can use the Add Word button to change the 
action or other word associated with a word. Note that the Add Word button is 
enabled only when a new word is typed in the edit area of the Words list. The words 
you add may contain virtually any character, but only words which contain 
embedded periods should have trailing periods (e.g., U.S.A. is OK, but USA. is not). 
Also, don't enter possessive word forms (e.g., enter Mary, not Mary's). 

Delete Word button -- Causes the word appearing in the edit area of the Words list to 
be removed from the currently selected dictionary. The associated action and other 
word are also removed. 

OK button -- Closes the Dictionaries dialog.  
Help button -- Takes you to a help screen similar to this. 

  
     This text is Copyright © 1998  Wintertree Software Inc. 

  
Spelling Checker Options  

You can use the Options Dialog to specify various spelling-checker options. These 
options affect the way the spell checker operates. 

  
  

Use these check boxes to customize your spell checking: 

Ignore Capitalized Words -- When enabled, any words beginning with a capital letter 
are ignored (i.e., are skipped over without being checked). You might enable this 
option if the text being checked contains many proper names. 

Ignore All-Caps Words -- When enabled, any words containing all capital letters are 
ignored (i.e., are skipped without being checked). You might enable this option if 
the text being checked contains many acronyms. 

Ignore Words with Numbers -- When enabled, any words containing embedded 
digits are ignored (i.e., are skipped without being checked). Examples of such words 
include "Win95" and "Q4." You might enable this option if the text being checked 
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contains many code-words or other symbols containing digits. 

Ignore Words with Mixed Case -- When enabled, any words containing an unusual 
mixture of upper- and lower-case letters are ignored (i.e., are skipped without being 
checked). Examples of such words include "MicroHouse" and "CapsLock." You 
might enable this option if the text being checked contains many variable names or 
other symbols which use case changes to distinguish words. 

Ignore Domain Names -- When enabled, any words that appear to be Internet domain 
names (such as wintertree-software.com) are ignored (i.e., are skipped without being 
checked). 

Catch Doubled Words -- When enabled, any word appearing twice in a row is 
reported via the  Check Spelling Dialog. 

Case Sensitive -- When enabled, a distinction is made between capitalized and non-
capitalized words. For example, "canada" is considered different from "Canada", so 
"canada" would be reported as a misspelling. When the option is disabled, "canada" 
and "Canada" are considered identical. Note that the performance of the spelling 
checker will be reduced if this option is disabled. 

Auto Correct -- When enabled, words marked with "Auto Change" actions will 
automatically be changed to their specified replacements. When disabled, you will 
be prompted before the words are changed. 

Phonetic Suggestions -- When enabled, suggestions are made on the basis of phonetic 
(sounds-like) similarity to the misspelled word. This option tends to improve 
suggestions for badly misspelled words. Enabling this option will increase the time 
required to locate suggestions. Note that either this option or the Typographical 
Suggestions option must be enabled or no suggestions will be offered. 

Typographical Suggestions -- When enabled, suggestions are made on the basis of 
typographical (looks-like) similarity to the misspelled word. This option is 
appropriate for people who are generally good spellers. Note that either this option 
or the Phonetic Suggestions option must be enabled or no suggestions will be 
offered. 

Suggest Split Words -- When enabled, two separate words will be suggested as a 
replacement for a misspelling containing two joined words. For example, "is the" 
would be suggested as a replacement for "isthe". 

  

Buttons:  

OK button -- Closes the Options Dialog, and saves any changes made to the option 
settings. 

Cancel button -- Closes the Options Dialog, and discards any changes made to the 
option settings. 

Help button -- Takes you to a help screen similar to this. 
  

This text is Copyright © 1998  Wintertree Software Inc. 
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Preview E-mail Service 

This dialog box appears whenever the "Preview E-mail" button is pressed on the 
toolbar of the main screen.  It enables you to review each message that is tagged for e-
mailing.  

  
 

The message for each reciprocal link with its e-mail column checked will be presented one 
at a time.  Note that this service only previews the messages for you.  No messages are 
actually e-mailed. 

Message Display -- Shows each e-mail message exactly as it will be sent so that you 
can be sure it is organized the way you want it. 

Help Button -- Takes you to this Help screen. 

OK Button -- Tells LinKtoLinK that you are happy with the message currently 
displayed and presents the next message for review.  If no message remains to be 
previewed, you will be returned back to the main screen. 

Do not send Button -- Instructs LinKtoLinK to flag the message currently displayed.  
It puts a yellow flag in the E-mail column of the appropriate link .  (It will not send 
this message if the Send E-mail service is launched.)  The next message is then 
presented for review.  If no message remains to be previewed, you will be returned 
back to the main screen. 
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Cancel Button -- Ends the message previewing and returns you to the main screen. 

 Use the Preview E-mail service to be sure that your e-mails give the impression you 
want to leave.  This is a good way to be sure that the field tags in your e-mail template are 
pulling out the right information from your site and link properties. 

  
Backup/Restore Database  

This service enables you to backup and restore your LinKtoLinK  database.  It appears 
whenever "Backup/Restore Database" is pressed within the Tools menu found on the 
main screen. 

  
  

These are the functions if you press the backup button:  

Backup to Display -- Shows the current directory where the backup files will be 
stored.  The default directory on entry is a  subdirectory under the location of 
LinKtoLinK.  If you kept the location recommended during program installation, 
this default directory will be c:\program files\linktolink\backup. 

Destination Drive -- Use the dropdown list box of available drives to select where you 
would like the backup files to reside.  No change is necessary if you wish to use 
LinKtoLinK defaults. 

Destination Folder -- Select the desired directory from the tree of directories.  A 
single click will select a directory in the list and a double click will open the 
directory so that its subdirectories can be seen.  Again no change is necessary if you 
wish to use LinKtoLinK defaults. 

Help Button -- Takes you to the Help screen you are currently looking at. 
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Backup Button -- Starts the backup process.  First LinKtoLinK will show you the date 
and time of the current database and that of any existing backup so you can decide 
whether or not to proceed. 

Close Button -- Returns you to the main screen. 
  

These are the functions if you press the restore button:   

Restore from Display -- Shows the current directory where the backup files are be 
stored.  The default directory on entry is a  subdirectory under the location of 
LinKtoLinK.  If you kept the location recommended during program installation, 
this default directory will be  c:\program files\linktolink\backup. 

Source Drive -- Use the dropdown list box of available drives to select where the 
backup files currently reside.  No change is necessary if you wish to use LinKtoLinK 
defaults. 

Source Folder -- Select the desired directory from the tree of directories.  A single 
click will select a directory in the list and a double click will open the directory so 
that its subdirectories can be seen.  Again no change is necessary if you wish to use 
LinKtoLinK defaults. 

Help Button -- Takes you to the Help screen you are currently looking at. 

Restore Button -- Starts the restore process.  First LinKtoLinK will show you the date 
and time of the current database and that of the backup so you can decide whether or 
not to replace the current database. 

Close Button -- Returns you to the main screen. 
  

 Be aware that LinKtoLinK will restart itself after exiting this service if a backup or a 
restore was completed.  There may be a noticeable pause while this restart takes place.  

  
Modify Link Categories 

This service enables you to create and modify link categories so that you can assign a 
category to each link in its properties dialog box.  It is accessed by pressing "Modify 
Link Categories" within the Tools menu found on the main screen. 
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This dialog box is organized from top to bottom as follows: 

Select a Site -- Use the dropdown list box of your websites to select which set of link 
categories to modify.  Each of your websites has its own set of categories since the 
sites may be significantly different from each other. 

Category Display -- Shows the list of categories that are associated with the site 
shown in the above dropdown box.   

Close Button -- Tells LinKtoLinK to return back to the main screen retaining the 
changes that were made. 

Add Button -- Use to add a new link category.  Once it is pressed, the cursor moves to 
a line in the category display so that you can enter the new category name. 

Delete Button -- Use to delete a highlighted category.  Prior to using this button,  press 
the arrow button  beside the category you want to delete, in order to highlight it. 
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Program Options 

The Program Options service enables you to tailor the many LinKtoLinK options to 
meet your needs.  It is accessed by pressing the Program Options button on the main 
screen toolbar or within the Tools menu.  This screen is organized into three tabs:  

 1. General 
 2. Program Defaults 
 3. Message Types (LinKtoLinK Pro feature) 

Buttons available from all tabs are listed at the bottom of this section. 

  
1. General Tab 

This tab stores the general program options. 

  
 

  Program Options 

Confirm before permanently deleting a link check box -- Check here if you want 
LinKtoLinK to get your confirmation before deleting a site or link. 

Prompt for backup check box -- Check here if you want LinKtoLinK to remind you 
to perform backups. 

 Every x days text box -- Enter here the frequency of being reminded to 
backup in days. 

  

Show Tips at Startup check box -- Check here if you want LinKtoLinK to show 
teaching Tips on entry into the program. 
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Clear Results Log each time you test links or send e-mail check box -- Check here 
if you want LinKtoLinK to clear the Results Log before logging in new information. 

  

  E-mail/Test Options 

Play WAV sound when tests and/or e-mail sending is complete check box -- Check 
here for LinKtoLinK to play a WAV sound after completing an Internet operation. 

 Sound to play display -- Shows the filename (including the full path) of the 
sound file to be played after the completion of link tests and e-mails. 

  

 Open Button -- Brings up the file dialog box so that you can load in a 
different sound file. 

  

   Play Button -- Plays the sound currently assigned.Open button --  to be 
played at startup. 

    
Blind Carbon Copies (BCC) -- Select the desired option button to send no BCC's or 

to send BCC's to yourself; i.e., to the e-mail address given in the appropriate site 
properties database. 

  
2. Program Defaults Tab 

This tab stores the program default settings for new sites. 

  
 

Webmaster -- Enter your webmaster's name in the text box.  (The <<MyWebmaster>> 
tag field in an e-mail template is replaced with the information stored here.) 
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   E-mail Settings 

Address -- Enter your e-mail address in the text box.  When transferred to into a new 
site property, it becomes the address that will be appear when someone replies to 
one of your e-mail messages.  

Sender --  Enter your e-mail sender's name in the text box.  When transferred to into a 
new site property, it becomes the name that will be identified as the sender in any e-
mail messages. 

Signature --  Enter your signature block in the multiple line text box.   
 

  E-mail Server (SMTP) Settings 

Host -- Enter the name of your e-mail server in the text box.  This should typically be 
the portion of your a-mail address after the "@" symbol. 

Port --  Enter the port number of your e-mail server (i.e., your SMTP - Simple Mail 
Transfer Protocol) in the text box.  By default this port number is set to 25.  Please 
do not change this number unless you are absolutely sure your e-mail service is 
using a non-standard port. 

  

  HTTP Server Settings  

Proxy -- Enter the name of your proxy server in the text box.  By default this field is 
left blank.  Please do not enter anything here, unless you know that a proxy server is 
being employed. 

Port (required) --  Enter the port number of your HTTP (i.e., your graphical web 
interface) in the text box.  By default this port number is set to 80.  Please do not 
change this number unless you are absolutely sure your http service is using a non-
standard port. 

 To save time when creating new sites, enter your typical e-mail settings and server 
settings in the program defaults tab in Program Options.  Information placed here is 
automatically entered into any new site that you create. 

  
3. Message Types Tab  

With LinKtoLinK Pro you can change the titles of the 8 message types to anything you want.  
You assign the new message titles in this tab. 
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Message title text boxes --  Enter the message titles in these 8 text boxes. 
  

  Use the offer check box  to denote those messages that should be treated as 
reciprocal link offers.  The offer count in the Reciprocal Link List is incremented 
whenever an offer-type e-mail message is received. 

  

  
General Buttons 

Help Button -- Takes you to this help screen. 

OK Button -- Implements any changes you have made to this screen and returns you 
to the main screen. 

Cancel Button -- Cancels any changes you have made to this screen and returns you to 
the main screen. 

Apply Button --  Implements any changes you have made to this screen. 

  
Site Report Dialog  

The Site Report dialog appears whenever "Site Report" is pressed within the File 
menu found on the main screen.  It enables you to print reports of each of your sites.  
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Print Current Site button -- Press here to print the site report of only the currently 
highlighted site. 

Print All Sites button -- Press here to print site reports of all sites. 

Cancel button --  Cancel print request and return to the main screen. 

  
Print Setup  

The Print Setup dialog appears whenever "Print Setup" is pressed within the File 
menu found on the main screen or within the Template menu found on the E-mail 
Template screen.  It enables you to change print drivers and various print options, 
depending on your print drivers. 

  
  

Printer Section 

Name -- Click on the option button to select whether the default printer or a specific 
printer will serve as the LinKtoLinK printer.  Use the dropdown list to change to 
another specific printer. 

Properties Button -- Click on this button to change specific properties of your printer. 
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Setup Options 

Paper -- Use the dropdown list boxes to specify paper size and paper source.  Specific 
list box text will vary from printer to printer. 

Orientation -- Use the option buttons to select "Portrait" or "Landscape" as the print 
orientation. 

Help Button -- Takes you to the Help screen you are currently looking at. 

OK Button -- Changes to the new printer setup and returns you to the previous screen. 

Cancel Button -- Takes you back to the previous screen without changing the printer 
setup. 

  Your dialog box may have different features from the one above depending on your 
printer and the installed driver. 
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Menu Bar Services 
 

Below is LinKtoLinK's menu bar, which is displayed on all screens: 
 

 
 

 The menu bar offers an alternative to using the toolbar.  In addition, it provides access to 
some special services that not available elsewhere.  The six menu services are:  File, Sites, 
Links, Tools, Help, and Register Pro (free unregistered version only).  Select the desired 
menu item by clicking on the word in the menu bar or by pressing the Alt-key and the letter 
that is underlined. 

  
File Menu  

 
 

The File menu features are described below: 

Preview E-mail -- Displays each e-mail message that is checked for sending so that 
you can be confident that exactly what you want is being sent.  (This service works 
for all of your sites, not just the currently active one!) 

Send E-mail -- Connects you to your SMTP Internet e-mail account as specified in site 
properties and sends the assigned message for those reciprocal links with a 
checkmark  in the E-mail column.  The checked reciprocal links may be from any 
of your sites -- it does not have to be the currently highlighted one! 

  

  You must have an active SMTP Internet e-mail account to send e-mail messages.  
(SMTP means a Simple Mail Transfer Protocol.)  Note that America On Line (AOL) 
has a proprietary network which may not permit you to send e-mails using 
LinKtoLinK.  With AOL you may have to cut and paste messages from the e-mail 
template screen then manually edit and use AOL's e-mail service. 

   

Test Links -- Tests each reciprocal link that is checked for testing.  (This service 
works for all of your sites, not just the currently active one!) 

  

   To test links, you must have an active Internet account and be using Internet 
Explorer 4.0+, Netscape 4.0+, or AOL Browser 4.0+ as your default browser.  
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(LinKtoLinK's Test Links service works fine on AOL using their version 4.0 browser.) 
  

  The link test service can test for the presence of your link on someone else's link 
page;  your image, such a banner or icon, on someone else's link page;  the reciprocal 
link on your link page;  and  the reciprocal image, such a banner or an icon, on your 
link page.  

  

  Based on link test results LinKtoLinK will automatically change link status: it will 
move a link to "Broken" if an agreed-to link is not found and it will move broken links 
back to "Active" if the links are later found. 

     

  If you are not already connected to the Internet,  LinKtoLinK will attempt to 
connect you using your Windows Internet dial-up capability in order to send e-mails 
and to test links. 

  

  You can also start any of these three services by pressing the appropriate icon in 
the toolbar. 

 

Import Links -- Takes you to the Link Harvest Wizard where you can collect links 
from a specified URL address.  (LinKtoLinK Pro feature only.) 

Export Links -- Enables you to create a simple link page in HTML of the links in your 
currently displayed reciprocal link list.  (LinKtoLinK Pro feature only.) 

 

Site Report -- Takes you to the site report dialog so that you can select to print reports 
of all your sites or only the currently active one.  

Print Setup -- Enables you to change printers (if available) and printer properties. 
  

Exit -- Takes you out of LinKtoLinK. 

  If you have set Program Options for "Prompt for backup every x days," it will 
determine the last time you backed up during exiting.  LinKtoLinK will remind you to 
back up your database if you have exceeded the specified number of days. 

   

  
Sites Menu 

  
 

The Sites menu features are described below: 
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New -- Asks you for a new site name and then opens a site properties screen so you can 
add a new site to "My Sites" list. 

Edit -- Opens the site properties screen of the currently highlighted site in "My Sites" 
list so that you can edit it. 

Copy -- Makes a copy of the currently highlighted site in "My Sites" list giving it the 
name "Copy of ..." 

Rename -- Goes into edit mode on the currently highlighted site in "My Sites" so that 
you can change its name. 

  

Delete -- Permanently removes the currently highlighted site in "My Sites" list and all 
its corresponding links. 

   

  Instead of using the Sites menu to make changes to My Sites, you can right click on a 
highlighted site.  This will display a dropdown menu with the same services. 

  

 Another way to delete a highlighted site is to press the Delete-key on the keyboard.  
Similarly, pressing the Insert-key while the Sites pane is active will add a new site. 

  

 You can also use the icons at the bottom of the My Sites pane of the Main Screen to add 
a new site or to edit, copy, or delete a highlighted site. 

  
Links Menu  

 
 

The Links menu features are described below: 

New -- Opens a new link properties screen so you can define a reciprocal link for the 
active site in "My Sites" list. 

Edit --  Opens the link properties screen of the currently highlighted link in the 
Reciprocal Link list so that you can edit it. 

Delete -- Permanently removes the currently highlighted link in the Reciprocal Link 
list. 
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Select All -- Selects and highlights all the links in the currently displayed reciprocal 
link list. 

 

Set E-mail -- Opens a pick list so that you can select the desired message to send about 
the currently highlighted link.  Selecting a message also leaves a check in the E-mail 
column of the link so that the message will be sent the next time the Send E-mail 
service is used. 

  Clicking the Set E-mail button on a link that is already checked for sending e-
mail will clear the check mark rather then open the pick list of messages. 

  

Set for Test -- Checks the Test column of the link that is currently highlighted.  
Clicking this button a second time will uncheck the column. 

Set Multiple Tests -- Opens a special dialog box where you can select (or unselect) all 
links of a particular status, such as all active ones, for link testing. Your selections 
are denoted with a check in the Test column of the link list.  You can select to test 
links at all sites or at just the currently active site via a special check box in the pick 
list. 

Change Status -- Opens a pick list so that you can change the status of the currently 
highlighted link. 

  

Sort Links -- Opens a dropdown menu so you can display your links in the order you 
wish to see them.  The links can be sorted alphabetically by website title, website 
description, and home page, among many other choices.  Alternately, the links can 
be in the order they were generated; i.e., "natural order." 

 

  A fast way to sort the Link List is to click on a title button above the list.  This will 
sort the list alphabetically based on the column selected.  (Note the Results column 
and the Note column cannot be sorted.) 

   

Customize Link List -- Opens a special pick list to change the column information of 
the Reciprocal Link list.  The order of the columns and additional fields can be 
added.  (LinKtoLinK Pro feature only.) 

  

 A number of the above operations can be applied to multiple rows.  Here are some 
examples: 

  

 To delete a range of links, click on the first row to be deleted, hold down the shift-key 
and click on the last row, and then press the Delete-button in the Links menu.   

  

  To flag a set of links for testing, hold down the ctrl-key and click one at a time on the 
rows you want to test, and then press the Set for Test-button in the Links menu. 

  

 Instead of using the Links menu to make changes to the reciprocal links list,, you can 
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right click on a highlighted link or set of highlighted links.  This will display a dropdown 
menu with the same services.  

  

 Another way to delete a set of highlighted links is to press the Delete-key on the 
keyboard.  Similarly, pressing the Insert-key while the Links pane is active will add a new 
link. 

 

 You can also use the icons at the bottom of the Reciprocal Links pane of the Main 
Screen to perform all of the above services except for sorting the links or customizing the 
list. 

  
Tools Menu 

 
 

The Tools menu features are described below: 

E-mail Templates -- Enables you to tailor site-by-site any of the 8 e-mail messages 
that you can use. 

  

Backup/Restore Database -- Creates a copy of the database for backup purposes or 
copies the last backup into the one used by LinKtoLinK. 

Repair Database -- Performs various repairs on a corrupted database, which may 
occur if you experienced a power outage while running LinKtoLinK. It should be 
used if LinKtoLinK begins acting in an unpredictable fashion. 

Compact Database -- Makes the database more compact if you have entered and 
deleted a variety of information.  It may also enable LinKtoLinK. to access the 
database faster. 

 

Modify Link Categories -- Enables you to create and modify link categories so that 
you can assign a category to each link in its properties dialog box. 

 

Set Program Options -- Enables you to tailor the many LinKtoLinK options to meet 
your particular needs.  

 

  
Help Menu  
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The Help menu features are described below: 

Contents (F1) -- Goes to the LinKtoLinK Help table of contents. 

Search For Help On -- Goes to the list of LinKtoLinK keywords. 

How To Use Help -- Goes an explanation of general Windows help features. 
  

Show LinKtoLinK Tip on Startup -- Click here to have a Tip appear at startup. 
  

Register LinKtoLinK Pro -- Takes you to the LinKtoLinK Pro registration screen.  
(Free unregistered version only.) 

  
LinKtoLinK Online Submenu: 

LinKtoLinK Home Page -- Connects you to the Internet and takes you to the 
LinKtoLinK home page. 

Product Support Page -- Connects you to the Internet and takes you to the 
LinKtoLinK product support page. 

Check for Updates -- Connects you to the Internet and determines whether or not 
you have the most current version.  If you do not, you will be given the 
opportunity to download the appropriate files. 

     Note that LinKtoLinK  can only connect you to the Web if you have an Internet 
account and a suitable browser. 

 
About LinKtoLinK -- Shows version, copyright, and system information. 

   To learn which LinKtoLinK  version you have, click on the Help Menu and select 
the About LinKtoLinK item.  The version number will be on the second line below the 
title bar.  (The version number is also shown on the "splash" screen that is displayed 
during startup.) 

 

   
Register Pro (free unregistered version only) 
The Registration Screen dialog appears whenever "Register Pro" is pressed on the 
menu bar of the main screen.  It enables you to upgrade your free unregistered 
version to take full advantage of the LinKtoLinK Pro features. 
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Follow the steps below to register: 

 1.  Press the button titled: "Click here to receive your registration code."  The screen 
that comes up provides specific information on how to receive your registration code 
over the Internet or by telephone. 

  2.  Once you have your registration code, re-enter this dialog. 
 3.  Enter your name and registration number in the text boxes provided. 
 4.  Press the OK button. 
 

 Congratulations!  You should now be a registered LinKtoLinK Pro user!
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Frequently Asked Questions 
  

Answers to the following frequently asked questions are given below. 

How to Add New Reciprocal Links? 
How to Add New Sites? 
How to Backup Your Database? 
How to Change Mail Templates? 
How to Compact Your Database? 
How to Customize LinKtoLinK Features? 
How to Delete Reciprocal Links? 
How to Delete Your Sites? 
How to Edit a Reciprocal Link? 
How to Edit One of Your Sites? 
How to Generate Link Pages Using LinKtoLinK? 
How to Import Link Data into LinKtoLinK? 
How to Make a Copy of One of Your Sites? 
How to Preview E-Mail? 
How to Print Site Reports? 
How to Repair Your Database? 
How to Restore a Previously Backed Up Database? 
How to Send E-Mail? 
How to Start Using LinKtoLinK? 
How to Test Links? 
What Are the System Requirements to Use LinKtoLinK? 
What Does It Mean to Repair or Compact My Database? 
What If I Have Technical Problems? 
What Is in the Help System? 

  
How to Add New Reciprocal Links?  

Look for the  button at the bottom of the Reciprocal Links pane of the main screen.  
Click it to add a link to the site that is currently highlighted in My Sites pane. 

Once this button has been clicked, LinKtoLinK displays a blank link properties dialog.  Enter 
the appropriate data on this new link and click the Ok-button to save it and exit. 

  The required fields in the properties screen are displayed in red.  They are: 
  

• Title 
• Home Page URL 
• E-mail Address 

  

  Keep in mind that even though you may place data on the properties screen, the 
record is not really stored in the database until the Ok-button or Apply-button has 
been clicked. 
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 Alternately, use the Link Harvest Wizard (a Pro feature) to gather link information from a 
specified Internet address and to automatically add new links to one of your reciprocal lists.  

  
How to Add New Sites?  

Look for the  button at the bottom of the My Sites pane of the main screen.  Click it 
to add one of your websites. 

Once this button has been clicked, LinKtoLinK asks for the name of your new site and then 
displays a blank site properties dialog.  Enter the appropriate data and click the Ok-button to 
save it and exit. 

  The required fields in the properties screen are displayed in red.  They are: 
  

• Site Title 
• Home Page URL 
• E-mail Address 
• E-mail Server 
• SMTP Port (defaulted to 25) 
• HTTP Port (defaulted to 80) 

  

  Keep in mind that even though you may place data on the properties screen, the 
record is not really stored in the database until the Ok-button or Apply-button has 
been clicked. 

  

  
How to Backup Your Database?  

Click on Tools in the menu bar of the main screen and then click on "Backup/Restore 
Database" in the dropdown menu. 

In the dialog box that appears, be sure that the  button is depressed to assure 
that the service is in the backup mode. 

LinKtoLinK displays the current destination where files will be backed up.  Click on the 
drive dropdown list box or the folder directory tree to select an alternate destination. 

After pressing the Backup button, the data/time of the current backup and the data/time of 
the current databases will be displayed in a dialog box. 

If you click the yes button, LinKtoLinK will replace the current backup with the current 
database. 

 You are strongly encouraged to frequently back up your work.  Otherwise, a power 
failure or a Windows crash could corrupt your database at the most inopportune time, and 
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you will not be able to quickly recover! 

 Be aware that LinKtoLinK will restart itself after exiting this service if a backup or a 
restore was completed.  There may be a noticeable pause while this restart takes place. 

  

Go to Backup/Restore Database in the Screen Features chapter for more details. 

  
How to Change Mail Templates?  

Click on the  button in the toolbar of the main screen. 
  

Go to E-mail Template in the Screen Features chapter for details. 

  
How to Compact Your Database?  

Click on Tools in the menu bar of the main screen and then click on "Compact 
Database" in the dropdown menu. 

This service makes the database more compact if you have entered and deleted a variety of 
information.  It may also enable LinKtoLinK. to access the database faster. 

In the dialog box that appears, LinKtoLinK will ask if you want to backup you database 
before compacting.  If you click on the yes button, it will take you to the backup dialog 
where you can replace the last backup with the current database.  When you exit from this 
dialog, LinKtoLinK will compact your database and restart the program. 

   

 You are strongly encouraged to make a backup if your current database is acting 
properly.  This service physically rewrites the database and makes it as compact as possible.  
Any power failure or Windows crash while you are in the middle of this service could 
destroy your database.  Better not take a chance! 

  
How to Customize LinKtoLinK Features?  

Click on the  button in the toolbar of the main screen. 
  

Go to Program Options in the Screen Features chapter for details. 

  
How to Delete Reciprocal Links?  

Highlight the link you wish to delete and then click on the  button at the bottom of 
the Reciprocal Links pane of the main screen. 

  
How to Delete Your Sites?  
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Highlight the site you wish to delete and then click on the  button at the bottom of 
My Sites pane of the main screen.  

  Deleting your site permanently deletes all associated reciprocal links as well! 
  

  
How to Edit a Reciprocal Link?  

Highlight the link you wish to edit and then click on the  button at the bottom of 
the Reciprocal Links pane of the main screen.  This brings up the link's properties 
dialog so that you can edit it. 

  
How to Edit One of Your Sites?   

Highlight the site you wish to edit and then click on the  button at the bottom of 
My Sites pane of the main screen.  This brings up the site's properties dialog so that 
you can edit it. 

  
How to Generate Link Pages Using LinKtoLinK? 

Press "Export Links" within the File menu found on the main screen.  This brings up 
the Export Links service which can create a simple categorized link page from your 
reciprocal link list information.  Refer to the Export Links service under Screen 
Features for further information.  (An exclusive LinKtoLinK Pro feature.) 

  
How to Import Link Data into LinKtoLinK? 

Press "Import Links" within the File menu found on the main screen.  This brings up 
the Link Harvest Wizard which helps you capture link information at a specified 
Internet address.  Refer to the Import Links service under Screen Features for further 
information.  (An exclusive LinKtoLinK Pro feature.) 

  
How to Make a Copy of One of Your Sites?  

Highlight the site you wish to copy and then click on the  button at the bottom of 
My Sites pane of the main screen.  This duplicates the properties of the selected site 
under the name of "Copy of ..."   At this point you can change the name "Copy of ..." 
to whatever you wish. 

  Making a copy of a site is often the fastest way to create an additional site that is 
very similar. 

 

  
How to Preview E-Mail?  

Click on the  button in the toolbar of the main screen. 
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Go to Preview E-Mail Service in the Screen Features chapter for details. 

  
How to Print Site Reports?  

Press "Site Report" within the File menu found on the main screen.  This brings up the 
Site Report dialog where you can print reports of each of your sites.  

  You have the option of printing only the report on the currently highlighted site or 
of all your sites. 

 

  
How to Repair Your Database? 

Click on Tools in the menu bar of the main screen and then click on "Repair 
Database" in the dropdown menu. 

This service performs various repairs on corrupted databases, which may occur if you 
experienced a power outage while running LinKtoLinK. It should be used if LinKtoLinK 
begins acting in an unpredictable fashion.  

In the dialog box that appears, LinKtoLinK will ask if you want to backup you database 
before repairing.  If you click on the yes button, it will take you to the backup dialog where 
you can replace the last backup with the current database.  When you exit from this dialog, 
LinKtoLinK will repair your database and restart the program. 

  

 If the database problems are severe and if you made a relatively recent backup, you may 
wish to skip backing up your current database.  Overwriting a good, but slightly old database 
with a bad database could make matters worse!  Another strategy would be to perform a 
backup, but to a new location so that you still have your older backup file as a last resort! 

  
How to Restore a Previously Backed Up Database?  

Click on Tools in the menu bar of the main screen and then click on "Backup/Restore 
Database" in the dropdown menu. 

In the dialog box that appears, press the  button to place this service in the 
restore mode. 

LinKtoLinK displays the current directory location destination where the files will be 
restored from.  Click on the drive dropdown list box or the folder directory tree to select an 
alternate location. 

After pressing the Restore button, the data/time of the current database and the data/time of 
the last backup will be displayed in a dialog box. 

If you click the yes button, LinKtoLinK will replace the current database with the last 
backup. 
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  Be aware that LinKtoLinK will restart itself after exiting this service if a backup or a 
restore was completed.  There may be a noticeable pause while this restart takes place. 

  

Go to Backup/Restore Database in the Screen Features chapter for details. 

  
How to Send E-Mail?  

Click on the  button in the toolbar of the main screen. 
  

Go to File in the Menu Bar Services chapter for details. 

  
How to Start Using LinKtoLinK?  

Here's how we suggest you start:  

√√ Look around the main screen which is the control center for LinKtoLink.  Notice that it 
is organized similar to Windows Explorer with split panes.  Look at the sample 
information in these panes to see how the lists are organized. 

√√ The left pane maintains your website information (aptly called "My Sites").  My Sites 
list works like the directory tree in Windows Explorer -- as you highlight different sites, 
the right pane displays different information.  The right pane maintains the Reciprocal 
Links list for your highlighted site.  Notice that it is organized with tabs. 

√√ Double click on the entry in My Sites list to see the properties associated with each of 
your sites.  Then double click on an entry in Reciprocal Links list to see its properties. 

√√ Click on the  button that appears below the menu bar to receive an orientation 
on how to organize your link information, to preview and send e-mails, and to test links. 

√√ To quit LinKtoLinK, just click on  in the title bar or on "File" and then "Exit"  in the 
menu bar .          

   
Suggested strategy for putting in your information into LinKtoLinK: 

√√ We recommend that you transform "My Site" into your first website if you were 
successful in sending e-mails in step 8 of the tutorial.  Highlight "My Site" and right 
click on it.  In the menu that drops down, select "rename" and change the name of this 
site to your website name.  Now double click on it and put your property information in 
the text boxes.  (Be sure to put your correct e-mail address and SMTP server 
information in site properties if you did not go through step 8 of the tutorial.) 

√√ You can also transform the sample reciprocal links by double clicking on them and 
putting appropriate information in their properties screen. 

√√ Now enter site appropriate property information in the Program Options "Program 
Defaults" tab.  Put only that information which will generally stay the same for each site 
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you add.  This information will automatically be transferred each time to your new sites 
-- this can be a great time saver! 

√√ Add a new site using the  button and complete its property information.  Then add 

any existing reciprocal links using the  button.  Change the status on these existing 
links to "Active."  As necessary, change the e-mail templates to fit the circumstances of 
this site. 

√√ Repeat the previous step until each of your sites has been added. 

√√  Now begin researching other websites that you would like to mutually link to and add 
them accordingly to the link list, keeping them in the default  status.  As you 

get responses to your e-mails, use the  button at the bottom of the 

Reciprocal Links list to move them to their new status; typically,  , 
 , or  . 

√√  Use the Link Harvest Wizard to capture link information and add new entries to your 
reciprocal link lists.  This is a good way to put your existing link page information into 
LinKtoLinK!  (Only available in LinKtoLinK Pro.) 

√√  Use the Export Links service to create your first categorized link page and to later 
update it by cutting and pasting the HTML code of the new links using a HTML editor.  
(Only available in LinKtoLinK Pro.) 

  
How to Test Links?  

Click on the  button in the toolbar of the main screen. 
  

Go to File in the Menu Bar Services chapter for details. 

  
What Are the System Requirements to Use LinKtoLinK?  

Below are the recommended minimum requirements: 

√√ 586/90 MHz PC-compatible system (Pentium-level recommended) 

√√ 16M of system memory 

√√ Minimum of 8 megabytes of hard disk space 

√√ CD-Rom drive (not needed if program downloaded) 

√√ VGA or higher resolution monitor (color recommended) 

√√ Mouse installed in Windows 

√√ Printer installed in Windows for site reports 
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√√ Connection to the Internet via modem or LAN 

√√ Internet browser:  Explorer 4.0+, Netscape 4.0+, or AOL Browser 4.0+ 

√√ SMTP Internet e-mail account  (Note that America On Line (AOL) has a proprietary 
network which may not permit you to send e-mails using LinKtoLinK) 

√√ Windows 95b, Windows 98, or Windows NT version 4.0 (service pack 3 or higher). 

  
What Does It Mean to Repair or Compact My Database?  

The Repair Database service performs various repairs on corrupted databases, which may 
occur if you experienced a power outage or a Windows "crash" while running LinKtoLinK. 
For example, it will repair the database indices which are essential for consistent displays 
and browsing.  Use the Repair Databases service if LinKtoLinK is acting in an unpredictable 
fashion. 

  

The Compact Database service makes the database more compact.  It does not alter 
database structures.  It consolidates data into an orderly file.   This service may make the 
databases faster to access, but will not correct a corrupted database--that is what the Repair 
Databases service is for. 

  
What If I Have Technical Problems?  

Boundaries Unlimited has made every effort to develop LinKtoLinK as an effective 
software tool, anticipating the broadest variety of hardware and software conditions.  
We have also taken special care to provide thorough on-line documentation.  If you are 
having difficulties, we urge you to study our tutorial and the help system for insight 
into a solution to your problem. 
 

 The "LinKtoLinK Online" submenu in the Help Menu can help you view the latest 
product support information at our website:  http://www.linktolink.com and to also check if 
you have the latest program.  If your version is out of date, you will have to the opportunity 
to download the latest maintenance release.  It can be installed over the free unregistered 
version or over LinKtoLinK Pro without losing your settings. 
 

It is impractical to provide extensive technical support and to maintain reasonable software 
prices.  Nevertheless, as a gesture of goodwill Boundaries Unlimited will attempt to assist 
you.  Support is provided as a courtesy to the extent practical, because we take pride in our 
work and want LinKtoLinK to be as useful to you as possible.  (On the other hand, the 
Limited Warranty describes our legal responsibilities.) 

  

We offer three ways for you to contact us with technical problems: 

√√ Submit a LinKtoLinK problem report at  http://www.linktolink.com/tsr.htm . 

√√ E-mail us at:  support@linktolink.com  (Please indicate tech support in the subject title.) 
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√√ Or write to us at:  

 Boundaries Unlimited, Inc. 
 Dept. LSX 
 P.O. Box 396 

  Gotha, FL   34734-0396 
  

Please provide us a description of the problem--what you expected and what LinKtoLinK 
did.  Please be as specific as possible:  what service you were using, precisely when the 
problem occurred, and what type of computer and operating system you were using. 

  
What Is In The Help System?  

The LinKtoLinK Help System consists of over 80 separate topics.  Some of these topics 
are contained in a single screen, while others fill a number of screens.  To advance to 
the next screen within the same topic, press the PgDn-key or use the vertical scroll bar. 

  

Click on the    button that appears below the menu bar of each LinKtoLinK help 
screen to go to the Table of Contents.  It consists of the following Chapters:   

√√ Welcome -- Presented the first time you enter LinKtoLinK. Good introductory material. 

√√ Tutorial -- A quick start lesson in using LinKtoLinK. 

√√ Overview -- Summary of main LinKtoLinK features. 

√√ Finding Appropriate Websites for Link Sharing  -- Gives tips to help you find high 
traffic sites willing to exchange links. 

√√ Screen Features -- Discusses the features in each LinKtoLinK screen. 

√√ Menu Bar Services -- Describes the items and submenus of the menu bar in the main 
screen. 

√√ Frequently Asked Questions -- Short answers to typical questions.  Provides jumps to 
detailed information. 

√√ Visual Glossary -- Brief explanations of the Windows control features which 
LinKtoLinK uses.  Great help for those new to Windows. 

√√ Technical Support -- Information to help if you have technical difficulties plus an 
invitation for user input and recognition of those who have already assisted us. 

√√ Legal Stuff -- What our lawyer requires. 

  

Training Suggestions: 

√√ Click on any of the above chapter names to jump to them. 

√√ Starting with Table of Contents,  click the    button just below the Help menu 
bar to browse through each help topic. 
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Visual Glossary  
Those of you that are new to Windows may be interested in reviewing the control 
features used in LinKtoLinK. We provide examples below to the following Windows 
controls: 

 Browse Controls, Check Box, Command Buttons, Dialog Box, Dropdown List Box, 
Dropdown Menu, Horizontal Scroll Bar, List Box, Menu Bar, Multiple Line Text Box, 
Option Buttons, Pane, Pick List, Tab, Text Box, Title Bar, Toolbar, and Vertical Scroll 
Bar. 

  

Refer to Microsoft Windows' documentation for other examples. 

  
Browse Controls 

Database browse controls are used to move from record to record.  They are present in the 
Site Properties and Link Properties screens. 

   
 

Click on the appropriate arrow icon to move to the previous or next record.  To accomplish 
the same on the keyboard, press the Alt-key and the letter underlined or press the tab key 
until the button is highlighted and then press the Enter key.  

  
  

Check Box 

A check box is used to indicate whether or not an option should be active.  Check boxes 
offer nonexclusive choices; that is if you have 2 check boxes either could be blank or X'ed 
without consideration to the other.  The example below is from Program Options. Here you 
indicate whether or not to play a WAV sound when testing or e-mail activity is complete. 

   
  

An X in a check box indicates that the option has been selected; otherwise, it is blank.  
Clicking on the box or its adjoining text toggles it to be X'ed or blank.  Pressing the spacebar 
when the check box is highlighted also toggles it on and  off.  If a check option is not 
available in a particular screen, it will be dimmed. 

  
Command Buttons 

Command buttons are used to activate many of the operations in each LinKtoLinK service.  
The example below shows the command buttons from Site Properties. 

  

Remember to press command buttons and menu buttons only once; otherwise, LinKtoLinK 
might do something unexpected.   

Here's another example of command buttons: 
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This is from Program Options .  It provides the filename and location of the WAV file to 
play after completing link testing and sending e-mails.  The folder icon serves as a command 
button to open a browse box so you can select the desired WAV file.  The right-arrow icon 
serves as a command button to preview the sound the WAV file produces. 

For related information, see Browse Controls in the Visual Glossary. 

  
Dialog Box 

A dialog box is used to display a message, confirm an action, or request information.  The 
example below illustrates a dialog box informing you of a duplicate site name when a saving 
a new site was attempted. 

  
 

  
Dropdown List Box 

A dropdown list box is used to select an item from a list.  It initially appears as a rectangular 
box with the current selection showing. 

  

When you click on the down-arrow to the right of the rectangular box, a list box drops 
down.  Clicking on the desired item in the list closes the box and places the selected item in 
the rectangular box.  Use the vertical scroll bar if the list extends beyond the rectangular 
box. 

Alternately, you can use the keyboard to tab into the rectangular box and press down-arrow 
and up-arrow to cycle through the items in the list.  When the item you want is displayed in 
the rectangular box, press the Tab-key to advance to the next field. 
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Dropdown Menu 

A dropdown menu is used to select a specific operation.  You get dropdown menus when 
you right click your mouse on either a site or link on the main screen.  The example below is 
the dropdown menu for the site list.  The menu item selected will occur on the highlighted 
site entry; in this case, the LinKtoLinK site.  

  

An item can be selected by clicking with your mouse or by pressing the Alt-key and the 
letter underlined in the menu. 

  
Horizontal Scroll Bar 

A horizontal scroll bar is used at the bottom of the Results Log in the main screen.  It is 
active if log information on a line cannot fit inside the width of the log display box. 

  
  

Click on the left or right arrows to move the text over a portion at a time.  Click within the 
bar to invoke greater line movement appropriately to the right or left of the slider.  You can 
also drag the slider top to a new location to control exactly what portion of the line you want 
displayed.  See the vertical scroll bar for related information. 

  
List Box 

A list box is used to select an item from a list.  The example below shows a list box used in 
the E-Mail Template service.  It is displayed when you click the "Insert Field Tag" button.  
You use it whether you wish to insert a field tag into the e-mail template. 
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  You can double click on an item to immediately select it.  This is generally faster 
than highlighting an item and then pressing the appropriate command button. 

  

  
Menu Bar 

A menu bar is used to access available menus.  The menu bar is an alternative to launching 
LinKtoLinK services through the toolbar .  In addition, it has some features that are not 
available anywhere else; such as the database backup/restore, repair, and compact utilities.  
In LinKtoLinK these menu items are File, Sites, Links, Tools, and Help. 

  
  

Each menu item contains a dropdown menu of actions or commands that you can carry out.  
Select the desired menu item by clicking on the word in the menu bar or by pressing the Alt-
key and the letter that is underlined.  As in other screens, any inactive commands will be 
dim. 

  
Multiple Line Text Box 

A multiple line text box is used for notes and journal entries.  The example below is from 
Link Properties. 

  

Word wraparound occurs whenever the text exceeds the line width.  A vertical scroll bar is 
provided on the right so you can access text beyond the display window. 
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Option Buttons 

Option buttons are used to select mutually exclusive options.  This is where only one button 
choice is allowed among the options.  The example below is from Program Options.  The 
black dot inside the circle indicates which option has been picked.  In this case, No Blind 
Carbon Copies has been selected. 

  

  
  

Clicking on the circle or its adjoining text activates the option.  Keyboard operations can be 
used by tabbing into a desired set of options and pressing an arrow key to change to select 
the particular one wanted.  If an option is not available in a particular screen, it will be 
dimmed. 

  
Pane 

Panes help separate portions of a window.  Windows Explorer, for example, has a folder 
pane on the left and a file pane on the right.  LinKtoLinK's main screen has a similar 
arrangement.  It has My Sites pane on the left and a Reciprocal List pane on the right.  
Below these split panes, it also has a Results Log pane.  My Sites pane is shown below: 

  

Clicking on one of your sites in the My Sites pane changes the information in the Reciprocal 
Link pane.  The Link pane always shows the links associated with the highlighted active 
site. 

   

  Double clicking on an item in the My Sites pane or the Reciprocal Link pane will 
take you to the properties of the selected item; i.e., either the appropriate site property 
or the appropriate link property. 

  

  Clicking on a column title in the Reciprocal Link pane will redisplay link 
information in alphabetical order based on the entries of that column. 
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   Typically, you can resize a pane by clicking on the fatter edge of the pane and 
dragging it to the desired new position.  To make the split panes taller so they can 
display more information, first make the entire LinKtoLinK window taller by dragging 
the top edge of the window to a higher position; then drag the divider between the split 
panes and the Results Log pane to a lower position. 

  

  
Pick List 

A Pick List is a List Box which is used to select a specific item.  Select an item by clicking 
on it (or using the down-arrow and up-arrow keys) and then pressing the OK-button.  The 
example below appears when the Set E-Mail button is pressed in the Main Screen: 

  
  

The Pick List example below appears when the Change Status button is pressed in the Main 
Screen: 

  
  

The Pick List example below appears when the Insert Field Tag button is pressed in the E-
Mail Template service: 
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  Double clicking on an item in a Pick List immediately selects that item. 
 

  
Tab 

A tab is used to select which folder or "index card" to bring into view.  The example below 
is from the Reciprocal Links pane on the main screen. 

  

  
 

Clicking on a tab will bring the information associated with that tab to the front.  In our 
example, clicking a tab will show the links that have a particular status. The All tab is a 
special case.  When it is selected, all links associated with the site highlighted in My Sites 
pane are shown, irrespective of status.  Note that in this example, the Inactive and Declined 
status tabs are hidden since the check box above the tabs is checked. 

Keyboard operations can typically be used to change which folder is active by pressing the 
TAB-key to reach the set of tabs and then pressing the left-arrow key or right-arrow key to 
select the one desired.  (Note that the tabs in the Reciprocal Links pane are not accessible by 
the keyboard.) 

  
Text Box 

A text box is used to enter a line of text.  In the example below from Site Properties you are 
asked to enter the title of the site. 

  

In some cases data entry is limited to only numbers.  In other cases, any keyboard character 
can be entered. 
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Title Bar 

A title bar is located above each window to describe its function.  The example below is 
from Site Properties. 

  

In addition to the name of the service, LinKtoLinK displays the name that is currently 
highlighted in My Sites.  This is especially help if you use the browse controls to look at the 
properties of various sites. 

  
Toolbar 

  

The LinKtoLinK toolbar is located below the menu bar.  It provides a quick way to launch 
frequently-used services.  These services in the order shown are:  preview e-mail, send e-
mail, test links, stop link testing or e-mail sending, e-mail templates, program options, and 
help for the main screen. 

  
Vertical Scroll Bar 

A vertical scroll bar is used to navigate through a list that is longer than the display space 
provided. 

  

Click on the top or bottom arrows to move one line at a time.  Click within the bar to 
simulate page down and page up movement.  Similarly, you can drag the slider top to a new 
location to control exactly what you want displayed.  See the Multiple Line Text Box for 
related information. 
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Technical Support 
  

Boundaries Unlimited has made every effort to develop LinKtoLinK as an effective 
software tool, anticipating the broadest variety of hardware and software conditions.  
We have also taken special care to provide thorough on-line documentation.   If you 
are having difficulties, we urge you to study our tutorial and the help system for insight 
into a solution to your problem.  

 The "LinKtoLinK Online" submenu in the Help Menu can help you view the latest 
product support information at our website:  http://www.linktolink.com and to also check if 
you have the latest program.  If your version is out of date, you will have to the opportunity 
to download the latest maintenance release.  It can be installed over the free unregistered 
version or over LinKtoLinK Pro without losing your settings. 

 

It is impractical to provide extensive technical support and to maintain reasonable software 
prices.  Nevertheless, as a gesture of goodwill Boundaries Unlimited will attempt to assist 
LinKtoLinK Pro users.  Support is provided as a courtesy to the extent practical, because we 
take pride in our work and want our products to be as useful to you as possible.  (On the 
other hand,  Limited Warranty describes our official position.  No support is provided to 
users of the free unregistered version.) 

  

We offer three ways for you to contact us with technical problems. 

√√ Submit a LinKtoLinK Pro problem report at http://www.linktolink.com/tsr.htm . 

√√ E-mail us at:  support@linktolink.com  (Please indicate tech support in the subject title.) 

√√ Or write to us at:  
  Boundaries Unlimited, Inc. 
  Dept. LSX 
  P.O. Box 396 
  Gotha, FL   34734-0396 
  

Please provide us a description of the problem--what you expected and what LinKtoLinK  
Pro did.  Please be as specific as possible:  what service you were using, precisely when the 
problem occurred, and what type of computer and operating system you were using. 

   Boundaries Unlimited, Inc. is a member of the Association of Shareware Professionals 
(ASP).  ASP wants to make sure that the shareware principle works for you.  If you are 
unable to resolve a shareware-related problem with an ASP member by contacting the 
member directly, ASP may be able to help.  The ASP Ombudsman can help you 
resolve a dispute or problem with an ASP member, but does not provide technical 
support for members' products.  Please write to the ASP Ombudsman at 157-F Love 
Ave, Greenwood, IN 46142 USA, FAX 317-888-2195, or send email to: 

  omb@asp-shareware.org. 
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User Input Invited 

We invite you to write with suggestions for new features and services.  While we cannot 
guarantee to upgrade the software to meet your unique needs, we carefully evaluate all 
user input and will accommodate as many improvements as practical in future 
LinkToLink updates. 

Please address your suggestions to: 

      Boundaries Unlimited 
     Dept. LSI 
     P.O. Box 396 
     Gotha, FL   34734-0396 
  

Or, e-mail us at:            support@linktolink.com
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Legal Stuff 
Copyrights and Trademarks 

The following is the copyright and trademark portion of the Warranty and License 
Agreement which you were alerted to read prior to using LinKtoLinK: 

  

Copyright (c) 2000  Boundaries Unlimited, Inc.  All rights reserved. 

"COPYRIGHT.  The SOFTWARE is owned by BU and is protected by United States 
copyright laws and international treaty provisions.  The SOFTWARE must be treated like 
any other copyrighted material except that you may make backup copies or transfer the 
SOFTWARE to a single hard disk provided that only one copy of the SOFTWARE is used 
at a time." 

"All brand and product names are trademarks and/or registered trademarks of their 
respective holders." 

  

Specifically all versions of the LinKtoLinK Program software, LinKtoLinK Setup software, 
LinKtoLinK On-line Help software, LinKtoLinK reports, and the  User's Guide (available in 
pdf format) are Copyright © 2000 by Boundaries Unlimited, Inc.  All rights reserved.  
LinKtoLinK and LinKtoLinK Pro are trademarks of Boundaries Unlimited, Inc. 

The spell checker portion of the LinKtoLinK software is Copyright © 1997 Wintertree 
Software Inc. 

Other trademarks are referenced only to define compatibility. 

  
License Agreement 

The following is the license agreement portion of the Warranty and License Agreement 
which you were alerted to read prior to using LinKtoLinK: 

  

Copyright (c) 2000  Boundaries Unlimited, Inc.  All rights reserved. 

"This is a legal agreement between you, the end user, and Boundaries Unlimited, Inc. 
("BU").  BY USING THE LINKTOLINK SOFTWARE, YOU ARE ACCEPTING THE 
TERMS OF THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS 
AGREEMENT, PROCEED NO FURTHER AND PROMPTLY RETURN ANY 
MATERIAL PROVIDED TO YOU WITH PROOF OF PAYMENT TO THE PLACE OF 
PURCHASE.  BU retains ownership of the LinKtoLinK software program.  This program is 
licensed to you for use only under the conditions as described below." 

"GRANT OF LICENSE.  BU grants you the right to use one copy of the LinKtoLinK 
software ("SOFTWARE") on a single computer with a single central processing unit (CPU).  
You may not network the SOFTWARE or otherwise use it on more than one computer 
terminal at the same time." 

"USER RESTRICTIONS.  The user may not rent or lease the SOFTWARE. However, the 
SOFTWARE may be transferred on a permanent basis provided you do not retain any copies 
yourself and the recipient agrees to the terms of this Agreement.  You may not reverse 
engineer, modify, alter, or adapt the software or documentation, including, but not limited 
to, translating, decompiling, disassembling, or creating derivative works.  This license and 
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your right to use the SOFTWARE automatically terminate if you fail to comply with any 
provision of this agreement." 

"U.S. GOVERNMENT RESTRICTED RIGHTS.  If this product is acquired under the 
terms of a: DOD contract: Use, duplication or disclosure by the Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of 252.227-7013.  Civilian agency contract: 
Use, reproduction or disclosure is subject to 52.227-19 (a) through (d) and restrictions set 
forth in this end user agreement.  Unpublished-rights reserved under the copyright laws of 
the United States.  Contactor/manufacturer is Boundaries Unlimited." 

"This Agreement is governed by the laws of the State of Florida." 

"Should you have any questions concerning this Agreement or wish to contact BU for any 
reason, please write:   

Boundaries Unlimited, Inc. 
P.O. Box 396 
Gotha, FL 34734-0396." 

  

  
Limited Warranty 

The following is the limited warranty portion of the Warranty and License Agreement 
which you were alerted to read prior to using LinKtoLinK: 

  

Copyright (c) 2000  Boundaries Unlimited, Inc.  All rights reserved. 

"LIMITED WARRANTY.  BU warrants that the SOFTWARE is free from defects in 
material and workmanship and will so remain for 90 days from the date of receipt.  BU will 
replace defective media or documentation at no charge, provided you return the item with 
dated proof of payment to BU.  If BU is unable to replace defective media or documentation, 
BU will refund the license fee.  These are your sole remedies for any breach of warranty.  
Except as specifically provided above, BU makes no warranty or representation, either 
express or implied, with respect to this SOFTWARE or documentation, including its quality, 
performance, merchantability, or fitness for a particular purpose." 

"BECAUSE SOFTWARE IS INHERENTLY COMPLEX AND MAY NOT BE 
COMPLETELY FREE OF ERRORS, YOU ARE ADVISED TO VERIFY YOUR WORK.  
IN NO EVENT WILL BU BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF 
OR INABILITY TO USE THE SOFTWARE OR DOCUMENTATION, EVEN IF BU IS 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN PARTICULAR, BU IS 
NOT RESPONSIBLE FOR ANY COSTS INCLUDING, BUT NOT LIMITED TO, THOSE 
INCURRED AS A RESULT OF LOST INFORMATION OR DATA, LOST PROFITS OR 
REVENUE, BUSINESS INTERRUPTION, LOSS OF USE OF SOFTWARE, THE COST 
OF RECOVERING SUCH SOFTWARE OR DATA, THE COST OF SUBSTITUTE 
SOFTWARE, CLAIMS BY THIRD PARTIES, OR OTHER PECUNIARY LOSSES.  IN 
NO CASE SHALL BU'S LIABILITY EXCEED THE AMOUNT OF THE LICENSE FEE." 

"The warranty and remedies set forth above are exclusive and in lieu of all others, oral or 
written, express or implied.  No BU dealer, distributor, agent, or employee is authorized to 
make any modification or addition to this warranty.  Some states or countries do not allow 
exclusions or limitation of implied warranties or limitation of liability for incidental or 
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consequential damages.  For such cases, the above limitation or exclusion may not apply to 
you.  If a part of this Agreement shall be determined by a court to be invalid, illegal or 
unenforceable, the remaining provisions shall in no way be affected or impaired thereby." 
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